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Warranty and liability 
 

Note The Application Examples are not binding and do not claim to be complete 
regarding the circuits shown, equipping and any eventuality. The Application 
Examples do not represent customer-specific solutions. They are only intended 
to provide support for typical applications. You are responsible for ensuring that 
the described products are used correctly These application examples do not 
relieve you of the responsibility to use safe practices in application, installation, 
operation and maintenance. When using these Application Examples, you 
recognize that we cannot be made liable for any damage/claims beyond the 
liability clause described. We reserve the right to make changes to these 
Application Examples at any time without prior notice. If there are any deviations 
between the recommendations provided in these application examples and other 
Siemens publications – e.g. Catalogs – the contents of the other documents 
have priority. 

We do not accept any liability for the information contained in this document. 
Any claims against us – based on whatever legal reason – resulting from the use 
of the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of 
a deficiency or breach of a condition which goes to the root of the contract 
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial 
contractual obligation are, however, limited to the foreseeable damage, typical for 
the type of contract, except in the event of intent or gross negligence or injury to 
life, body or health. The above provisions do not imply a change of the burden of 
proof to your detriment. 
Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of the Siemens AG. 
 

Security 
infor-

mation 

Siemens provides products and solutions with industrial security functions that 
support the secure operation of plants, solutions, machines, equipment and/or 
networks. They are important components of a holistic industrial security 
concept. With this in mind, Siemens’ products and solutions undergo continuous 
development. Siemens recommends strongly that you regularly check for 
product updates. 

For the secure operation of Siemens products and solutions, it is necessary to 
take suitable preventive action (e.g. cell protection concept) and integrate each 
component into a holistic, state-of-the-art industrial security concept. Third-party 
products that may be in use should also be considered. For more information 
about industrial security, visit http://www.siemens.com/industrialsecurity. 

To stay informed about product updates as they occur, sign up for a product-
specific newsletter. For more information, visit 
http://support.automation.siemens.com. 

 
 

http://www.industry.siemens.com/topics/global/en/industrial-security/Pages/default.aspx
http://support.automation.siemens.com/
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1 Automation Task 
Introduction 

If we consider a facility for the production of food or pharmaceutical products and 
its technical processes, we will realize that certain process steps, procedures and 
devices are repeated in the same or similar form. 
An important process in this regard is the automated cleaning of the apparatus and 
plant sections. 
This process is becoming more and more important with increasing plant size, 
since manual cleaning is no longer possible. One efficient process is the "Cleaning 
in Place" process, called "CIP Process" for short. 
The CIP process enables the cleaning of apparatus and plant sections in place. 
Disassembly is not necessary. As a result of this kind of automated cleaning, 
valuable working time is also saved. 

Overview of the automation task 
The CIP system is used for cleaning the other plant sections and fittings. 
The individual fittings are controlled by the automation program. 

Description of the automation task 
The fluids required for cleaning are prepared and held ready in the CIP system. 
There are different fluids for the different cleaning phases, and these must always 
be available in sufficient quantities. For this reason, the fill level in the storage 
tanks must be continuously monitored. If the levels are too low, fluid must be 
supplied to the tanks. 
In addition to the fill level, the quality of the fluid is also important. For this reason, 
the fluids in the tanks are controlled to a predefined temperature and concentration 
of detergent. Consequently the temperature and concentration are also 
continuously monitored and adjusted if necessary. 
A further task is to reuse as much cleaning fluid as possible after use. To this end, 
the quality in the return line is checked again. If the quality meets the 
specifications, the fluid will be automatically fed back to the tanks provided thy are 
not full. If the quality is not adequate or the tanks are full, the fluid will be disposed 
of. 
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2 Automation Solution 
2.1 Overview of the complete solution 

The figure below shows schematically the structure of the solution: 
Figure 2–1 

 
 
The "CIP" application example is implemented as a SIMATIC PCS 7 multiproject in 
accordance with ISA S88.01.  
The multiproject consists of an AS project (user program), an OS project 
(visualization with process pictures), as well as a SIMATIC BATCH system 
(production and cleaning recipes). 
The AS project has been created with the APL library (Advanced Process Library), 
the BRAUMAT library - and SIMATIC BATCH blocks. 
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Advantages 
This application offers you the following advantages: 
• Implementation of a CIP system conforming to ISA S88.01 
• Description of the most important automation functions for a CIP system 

Limitation 
The following special cases are not covered by the "CIP" application example: 
• Simultaneous cleaning of plant sections 
• Technical process simulation 

Required knowledge 
Fundamental knowledge of the following specialist fields is a prerequisite: 
• Configuring with SIMATIC PCS 7, SIMATIC BATCH and the APL library 
• Knowledge of control technology 
• Basic knowledge of process technology 



2 Automation Solution 
 

 

CIP – Cleaning in Place 
V2.0, Entry ID: 78463886 7 
 


 S

ie
m

en
s 

AG
 2

01
5 

Al
l r

ig
ht

s 
re

se
rv

ed
 

2.2 Core functionality 

The "CIP" application example includes the user program with typical 
measurement points for a CIP system. 
The plant hierarchy (PH) is constructed according to ISA S88.01. The equipment 
modules necessary for the CIP system are defined. A plant overview picture and 
an overview picture with BATCH OCXn are included for operation.  
The figure below shows the BATCH OCX overview picture: 
Figure 2–2 

 
A SIMATIC BATCH backup with a sample recipe is included for creating cleaning 
batches. 
The application example does not include any simulation. For this reason, changes 
to process values must be made manually to produce changes in the program 
sequence. The setpoints in the recipes are freely selected and may deviate 
depending on the plant. The equipment modules and measurement points are 
used as an exemplary template and with plant-specific adaptations can be applied 
to a real production plant. 
The cleaning recipes must be created for the plant sections to be cleaned 
depending on construction and product. The example recipe merely describes 
the basic construction. 
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2.2.1 Description of the individual functions 

The individual parts of a CIP system are described in the following. The entry point 
is the process picture of the visualization screen. 
Figure 2–3 

1

2
3 4

5

 
The process picture of the CIP system consists of the following main parts: 
1. CIP return modules 
2. Post-rinse tank 
3. Detergent tank 
4. Pre-rinse tank 
5. CIP supply modules 

 

1. CIP return 
The CIP return is used to recover the used CIP fluids. Depending on the fill level 
in the tanks, the quality (temperature and detergent concentration) and also the 
current cleaning phase, the fluid is fed into the appropriate tanks or into the drain. 
This takes place with the aid of sensors and valves. 

2. Post-rinse tank 
The cleaning fluid (e.g., water) for the final cleaning phase is stored in the post-
rinse tank. Fluid can be drawn off provided the level does not fall below the 
minimum fill level. 
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3. Detergent tank 
The detergent tank contains the cleaning fluid for the second cleaning phase. 
In this tank the fluid is heated up to the prescribed temperature and the necessary 
detergent concentration is established. The fluid is permanently pumped through 
a heating circuit so that it will always be at the specified temperature. Depending 
on the temperature, the detergent concentration is measured (from its 
conductance). If this is too low, detergent is added. 
The detergent tank can also be filled with fresh water. This is possible when there 
is no CIP phase active, as the temperature and the concentration have to be 
adjusted to the correct values again.  

Note The detergent tank is an example of an acid or lye tank. 

 
 

4. Pre-rinse tank 
The pre-rinse tank contains the cleaning fluid for the first cleaning phase. The fluid 
removes contamination and product residues from the pipes and apparatus. 
The tank is filled with fresh water or CIP fluid from the other cleaning phases. 
The tank can be filled provided the maximum fill level has not been reached. 
If a particular temperature and/or detergent concentration for the fluid is necessary 
for process-related reasons, the fluid can be prepared in the same way as 
described for the detergent tank. 

5. CIP supply 
The CIP fluids are fed from the CIP tanks through the CIP supply line into the parts 
of the plant that are to be cleaned. The flow from the tanks into the supply line is 
controlled by valves. The appropriate valve is opened depending on which cleaning 
phase is active. The flow quantity is controlled by a pump. 
Before the fluid is drawn off, it is checked to confirm that it meets the quality 
requirements or that sufficient fluid is available. 

Additional functions 
In addition to the "CIP" CIP system, the example project also contains the "MIX 
PLANT" plant section. This is used to demonstrate cleaning with a CIP system. 
The plant section consists of the mixer to be cleaned at well as the "TANK_IN" 
(tank inlet) and "TANK_OUT" (tank outlet) equipment modules.  

Advantages of this solution 
• A reduction of the knowledge necessary to develop applications 
• A reduction in the configuration effort 
• More flexible setup and adaptation due to technical functions 
• Standardized structures 
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2.2.2 PI process picture 

The figure below shows the PI flow diagram of the CIP system. The measurement 
points that are contained in the project have been entered. 

Figure 2–4 
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2.3 Hardware and software components used 

The application example has been created with the following components: 

Hardware components 
Table 2–1 

Component Note 

SIMATIC PCS 7 ES/OS IPC847D W7  For the PCS 7 V8.1 example project 

 

Note In case of different hardware, please take heed of the minimum requirements for 
installing the software components. The minimum requirements can be found in 
the Read Me file of the PCS 7. 

 

Standard software components 
Table 2–2 

Component Note 

SIMATIC PCS 7 V8.1 Part of SIMATIC PCS 7 ES/OS IPC847D W7 
S7-PLCSIM  Not part of SIMATIC PCS 7; appropriate licenses are 

required. 
APL library V8.1 Part of SIMATIC PCS 7 V8.1 
SIMATIC BATCH V8.1 Not part of PCS 7; appropriate licenses are required. 
BRAUMAT Library V7.1 Not part of PCS 7; appropriate licenses are required. 

Example files and projects  
The following list contains all the files and projects used in this example. 
Table 2–3 

Component Note 

78463886_CIP_PCS7V81.zip PCS 7 V8.1 example project 
78463886_CIP_de.pdf This document 
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3 Basics 
3.1 Process engineering 

Cleaning in Place (CIP) 
The term "Cleaning in Place", or CIP for short, describes a process which is used 
in the process industry for cleaning plant parts. The advantage of the process is 
that the cleaning takes place directly on the plant part in situ, without it having to 
be dismantled. 
A separate plant section is added to the plant for the CIP process. The cleaning 
fluid is prepared and stored here. The plant sections to be cleaned are designed 
so that they can be connected to the CIP plant section. The CIP plant section is 
positioned so that the paths to the plant sections to be cleaned are as short as 
possible. 
 

3.2 Automation technology 

The "unit" concept 
In this application example, the "CIP" plant section can be regarded as a unit. 
The term "unit" means a unit in process-related plants (plant section, apparatus, 
machines) including the sensors, actuators and the assigned automation software 
that is frequently required in this configuration of components. The unit as a "Type" 
is used as a template for generating many different programmable instances. 
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ISA-88 
The application example is configured in accordance with the ISA-S88 standard. 
The standard describes a process with reference to the equipment available 
(physical model), the defined technical process (process model) and the equipment 
that is used to produce a batch (procedural control model). The figure below 
describes the structure of the ISA-S88 standard. 
Figure 3–1

 
 

Note You will find detailed information on ISA-S88.01 in the manual "SIMATIC 
Process Control System PCS 7 SIMATIC BATCH V8.1", in the chapter 
"Technological basics complying with ISA-88.01". You will find this manual at the 
following link: http://support.automation.siemens.com/WW/view/en/103173731 
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4 Design and principle of operation 
4.1 Project structure 

4.1.1 CFC chart structures 

A uniform naming convention has been used for identifying the measurement 
points - the function is named according to the European standard EN 62424. 
The following figure shows the composition of a measurement point name: 
 
Figure 4–1 

TIC_Detergent

Funktion
T = Temperatur(Erstbuchstabe)
I = Anzeige (Folgebuchstabe)
C = Regelung (Folgebuchstabe)

Bezeichnung

 
 

The following table contains the letters used in the application and their meanings: 
 
Table 4–1 

First letter Meaning 

F Flow 
L Level 
N Motor 
P Pressure 
Q Master value 
C Speed (velocity, rotational speed, frequency) 
T Temperature 

X Freely selectable first letter 
Y Control valve 

 
Table 4–2 

Subsequent letter Meaning 

C Control 
F Fraction 
I Indication 
S Switching binary control function or switching function 

(non-safety-related) 
T Monitoring (transmitter, analog value processing) 
H High (top) 
L Low (bottom) 
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4.1.2 Technological perspective 

The plant hierarchy of the "CIP" application example is configured according to 
ISA S88.01. 

AS Project 
In the AS project, "CIP_AS", the first plant hierarchy level, "PRODUCTION", 
is defined as the plant and contains the neutral hierarchy folders. 
• "CIP" contains the "CIP" hierarchy folder, defined as a plant section 
• "MIXER PLANT" contains the "MIXER" hierarchy folder, defined as a plant 

section 
• "RECIPE CONTROL" contains no other objects 
The "CIP" plant section contains the "UNIT_CIP" CFC diagram with the 
"UNIT_PLC" block, the hierarchy folders for the "CIP_SUPPLY" and 
"CIP_RETURN" equipment modules and the neutral hierarchy folders for the tanks 
in the CIP system. The necessary measurement points are located in these folders. 
The "MIXER" plant section contains the "UNIT_MIXER" CFC diagram with the 
"UNIT_MIXER" "UNIT_PLC" block and the hierarchy folders for the "TANK_IN" and 
"TANK_OUT" equipment modules. The necessary measurement points are located 
in these folders. 
The following figures show the structure of the AS project: 
 
Figure 4–2 
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Figure 4–3 
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OS project 
The plant hierarchy in the OS project is derived from the plant hierarchy for the 
AS project. The "IP", "MIX PLANT" and "RECIPE CONTROL" neutral hierarchy 
folders contain the "OVERVIEW_CIP.pdl", "OVERVIEW_MIXPLANT.pdl" and 
"SIMATIC_BATCHOS.pdl" overview images. The "IP" and "MIX PLANT" hierarchy 
folders, defined as plant sections, contain the "CIP.pdl" and "MIXER.pdl" images. 
 
Figure 4–4 
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4.2 Technical functions and measurement points 

The "CIP" application example is composed of various technical functions and 
measurement points. In a PCS 7 project, all measurement points, including the 
measurement points for the technical functions, are based on measurement point 
types from the master data library. The process tag types that are used in the 
project are taken from the APL library. SFC types, which are also included in 
the master data library, are used to describe the technical functions. 
In the following chapters you will find information on the structure of the individual 
technical functions. You will also find a description of the SFCs used. 

4.2.1 CIP SUPPLY 

The detergent is fed from the tanks to the individual sections of the plant via the 
CIP supply. Which detergent is used is implemented by means of an SFC type 
instance. The fluid is taken from the appropriate tank, depending on which control 
strategy is selected. The quantities taken are defined by cleaning recipes in 
SIMATIC BATCH. The cleaning is carried out using cleaning batches and thus 
is also logged. 

Design 
The figure below shows the design of the supply apparatus: 
Figure 4–5 

CLt Supply
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The supply valves for the tanks are opened and closed by an instance of the "CIP 
SUPPLY" SFC type.  
The following table provides you with an overview of the elements and 
measurement point types used. 

Table 4–3 

Name Process tag type Description 

CIP_Supply "CIP SUPPLY" SFC type • Opening and closing the valves according to the 
specified control strategy 

• Starting and stopping the pump 
NC_Supply "MotorSpeedControlled" Motor for driving the pump 
YS_SupDetergent "ValveLean" "Detergent tank valve" process tag 
YS_SupPostRinse "ValveLean" "Fresh water tank valve" process tag 
YS_SupPreRinse "ValveLean" "Pre-rinse tank valve" process tag 
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Connecting the process tags 
The following figure shows schematically the supply apparatus including 
the connections or SFC accesses that span the CFC diagram. 
Figure 4–6 

YS_SupDetergent

Valve

Fbkhpenhut

Valve

CLt_SUttLY

CLt_Supply

CLt_Supply

RdyToStart

RdyToReset

FbkClosehut

Ctrl

AutAct

YS_SuptreRense

Valve

Valve

YS_SuptostRinse

Valve

Valve

hpenAut

ModLihp

RstLi

hpenAut

ModLihp

AutModLi

RstLi

hccupied

BatchName

BatchLD

BatchEn

StepNo

hpenAut

ModLihp

AutModLi

RstLi

hccupied

BatchName

BatchLD

BatchEn

StepNo

Fbkhpenhut

RdyToStart

RdyToReset

FbkClosehut

Ctrl

AutAct

Fbkhpenhut

RdyToStart

RdyToReset

FbkClosehut

Ctrl

AutAct

hccupied

BatchName

BatchLD

BatchEn

StepNo

AutModLi

NC_Supply

MotorSpeedContr

MotorSpeedContr

StopAut

St_Lihp

AutModLi

RstLi

hccupied

BatchName

BatchLD

BatchEn

StepNo

St_ExtAct

Rev

Rbkhut

FbkRevhut

FbkFwdhut

AutAct

St_LntLi

St_ExtLi

FwdAut

RevAut

ModLiphp

 



4 Design and principle of operation 
 

 

CIP – Cleaning in Place 
V2.0, Entry ID: 78463886 20 
 


 S

ie
m

en
s 

AG
 2

01
5 

Al
l r

ig
ht

s 
re

se
rv

ed
 

Parameter assignment 
The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter 4.3.1, 
"Sequencers". 

NC_Supply 
The flow quantity of the cleaning fluid is controlled in the "NC_Supply" process tag. 
The setpoint is specified by means of the "CIP SUPPLY" SFC type instance. 
The "NC_Supply" process tag is an instance of the "MotorSpeedControlled" 
process tag type. 
The following table shows the configuration of the instance from 
"MotorSpeedControlled". 
 
Table 4–4 

Block Connection Value Usage 

FbkFwd SimPV_In 1 Simulated process value 

RbkSpeed PV_InUnit 1342 
Unit of measure of input signal, percent 
% 

RbkSpeed SimOn 1 Simulation switched on 
RbkSpeed SimPV_In 28.0 Simulated process value 
Interlock - - Removed 
Intlk04 - - Inserted as IntlkMot 

IntlkMot In01 - 
Connection to 
YS_SupPostRinse\Valce.FbkOpenOut) 

IntlkMot In02 - 
Connection to 
YS_SupDetergent\Valve.FbkOpenOut 

IntlkMot In03 - 
Connection to 
YS_SupPreRinse\Valve.FbkOpenOut 

IntlkMot Out - 
Logic result connected to NC_Supply\ 
MotorSpeedContr.Intlock 

Protect In01 1 Connection removed, value "1" 

OR_OOS In7 - 
Visible connection to 
NC_Supply\2.OosAct 

MotorSpeedContr FwdAut - 

Switch on forward in automatic mode 
(CIP_Supply\CIP 
SUPPLY.M1_FwdAut) 

MotorSpeedContr StopAut - 

Stop motor in automatic mode 
(CIP_Supply\CIP 
SUPPLY.M1_StopAut) 

MotorSpeedContr RevAut - 

Switch on reverse in automatic mode 
(CIP_Supply\CIP 
SUPPLY.M1_StopAut) 

MotorSpeedContr ModLiOp - 

Switching between modes (operator or 
connection/SFC 
(CIP_Supply\CIP 
SUPPLY.M1_ModLiOp) 

MotorSpeedContr SP_ext - 
External setpoint (CIP_Supply\CIP 
SUPPLY.M1_SP_Ext) 

MotorSpeedContr SP_HiLim 60.0 Upper limit of the setpoint 
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Block Connection Value Usage 

MotorSpeedContr SP_LiOp - 

Setpoint source internal/external 
(CIP_Supply\CIP 
SUPPLY.M1_SP_LiOp) 

MotorSpeedContr SP_ExtLi - 

External setpoint via the 
CIP_Supply\CIP 
SUPPLY.M1_SP_ExtLi connection 

MotorSpeedContr SP_IntLi - 

Internal setpoint via the 
CIP_Supply\CIP SUPPLY.M1_SP_IntLi 
connection 

MotorSpeedContr Monitor 0 
Monitoring of checkback signals 
deactivated 

MotorSpeedContr RstLi - 
Reset via the CIP_Supply\CIP 
SUPPLY.M1_RstLi connection 

MotorSpeedContr Interlock - 
Interlocking without resetting 
(CIP_Supply\IntlkMot.out) 

MotorSpeedContr BatchEN - 
Occupation release (CIP_Supply\CIP 
SUPPLY.QBA_EN) 

MotorSpeedContr BatchID - 
Batch number (CIP_Supply\CIP 
SUPPLY.QBA_ID) 

MotorSpeedContr BatchName - 
Batch name (CIP_Supply\CIP 
SUPPLY.QBA_NA) 

MotorSpeedContr StepNo - 
Batch step number (CIP_Supply\CIP 
SUPPLY.QSTEP_NO) 

MotorSpeedContr Occupied - 
Occupied by batch (CIP_Supply\CIP 
SUPPLY.QOCCUPIED) 

MotorSpeedContr AV - 
Additional analog value 
(NC_Supply\FLOW.AV_Tech) 

MotorSpeedContr GrpErr - 
Group error (CIP_Supply\CIP 
SUPPLY.M1_GrpErr) 

MotorSpeedContr RdyToStart - 
Ready to start (CIP_Supply\CIP 
SUPPLY.M1_RdyToStart) 

MotorSpeedContr RdyToReset - 
Ready to reset (CIP_Supply\CIP 
SUPPLY.M1_RdyToReset) 

MotorSpeedContr Fwd - 
Activate forward (CIP_Supply\CIP 
SUPPLY.M1_Fwd) 

MotorSpeedContr Rev - 
Activate reverse (CIP_Supply\CIP 
SUPPLY.M1_Rev) 

MotorSpeedContr AutAct - 
Automatic mode (CIP_Supply\CIP 
SUPPLY.M1_AutAct) 

MotorSpeedContr FbkFwdOut - 

Feedback message "Forward mode" 
(CIP_Supply\CIP 
SUPPLY.M1_FbkFwdOut) 

MotorSpeedContr FbkRevOut - 

Feedback message "Reverse mode" 
(CIP_Supply\CIP 
SUPPLY.M1_FbkRevOut) 

MotorSpeedContr SP_ExtAct - 

External setpoint active 
(CIP_Supply\CIP 
SUPPLY.M1_SP_ExtAct) 

MotorSpeedContr RbkOut - 

Output "Readback value" 
(CIP_Supply\CIP 
SUPPLY.M1_RbkOut) 

Error In8 - (NC_Supply\ ScalePV.Bad) 
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Block Connection Value Usage 

Pcs7AnIn - - Inserted as "ScalePV" 
ScalePV Scale 70 Scaling of the process value 

ScalePV PV_InUnit 1349 
Unit of measure of the process value in 
cubic meters per hour m³/h 

ScalePV SimOn 1 Simulation on 
ScalePV SimPV_In 26 Simulated process value 
ScalePV Mode 16#00 Status of value and measurement type 

ScalePV MS_Release - 
Release for maintenance 
(NC_Supply\FLOW.MS_Release) 

AV - - 
Inserted as FLOW for additional analog 
value 

FLOW AV - 
Additional analog value (NC_Supply\ 
ScalePV.PV_Out) 

FLOW AV_Unit - 

Unit of measure for an additional 
analog value (NC_Supply\ 
ScalePV.PV_OutUnit) 

FLOW AV_OpScale - 

Limiting value for the scales on the bar 
graph display (NC_Supply. ScalePV 
\ScaleOut) 

FLOW SV_Out - 

Output for the analog value 
(CIP_Supply\CIP 
SUPPLY.RINSE_FLOW_AI) 

 
The IntlkMot block is used to interlock the motor. This ensures that the motor only 
runs if one of the valves is open as well.  
The following figure describes the interlocking and how it can be canceled. 
 
Figure 4–7 

Motor is locked
because valves are

closed
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YS_SupDetergent 
The "YS_SupDetergent" process tag controls the discharge from the detergent 
tank into the supply inlet. The valve block receives the command to open or close 
from the "CIP SUPPLY" SFC type instance. The "YS_SupDetergent" process tag 
is an instance of the "ValveLean" process tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–5 

Block Connection Value Usage 

FbkOpen PV_In 0 
Feedback message "Valve open", 
connection removed 

FbkClose PV_In 0 
Feedback message "Valve closed", 
connection removed 

Permit In01 0 
Release to open or close from the 
neutral position, connection removed 

Interlock In01 0 Interlock, connection removed 

Protect In01 0 
Protective interlock, connection 
removed 

Valve OpenAut - 

Open valve in automatic mode, 
(CIP_Supply\CIP 
SUPPLY.V2_OpenAut) 

Valve ModLiOp - 

Switch between operator/connection 
modes (CIP_Supply\CIP 
SUPPLY.V2_ModLiOp) 

Valve RstLi - 
Reset via the (CIP_Supply\CIP 
SUPPLY.V2_RstLi) connection 

Valve BatchEn - 
Occupation release (CIP_Supply\CIP 
SUPPLY.QBA_EN) 

Valve BatchID - 
Batch number (CIP_Supply\CIP 
SUPPLY.QBA_ID) 

Valve BatchName - 
Batch name (CIP_Supply\CIP 
SUPPLY.QBA_NA) 

Valve StepNo - 
Batch step number (CIP_Supply\CIP 
SUPPLY.QSTEP_NO) 

Valve Occupied - 
Occupied by batch (CIP_Supply\CIP 
SUPPLY.QOCCUPIED) 

Valve RdyToStart - 
Ready to start (CIP_Supply\CIP 
SUPPLY.V2_RdyToStart) 

Valve RdyToReset - 
Ready to reset (CIP_Supply\CIP 
SUPPLY.V2_RdyToReset) 

Valve Ctrl - 
Control output (CIP_Supply\CIP 
SUPPLY.V2_Ctrl) 

Valve AutAct - 
Automatic mode active 
(CIP_Supply\CIP SUPPLY.V2_AutAct) 

Valve FbkOpenOut - 
Valve open (CIP_Supply\CIP 
SUPPLY.V2_FbkOpenOut) 

Valve  FbkClosedOut - 
Valve closed (CIP_Supply\CIP 
SUPPLY.V2_FbkCloseOut) 
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YS_SupPostRinse 
The "YS_SupPostRinse" process tag controls the discharge from the fresh water 
tank into the supply inlet. The valve block receives the command to open or close 
from the "CIP SUPPLY" SFC type instance. The "YS_SupPostRinse" process tag 
is an instance of the "ValveLean" process tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–6 

Block Connection Value Usage 

FbkOpen PV_In 0 
Feedback message "Valve open", 
connection removed 

FbkClose PV_In 0 
Feedback message "Valve closed", 
connection removed 

Permit In01 0 
Release to open/close from the neutral 
position, connection removed 

Interlock In01 0 Interlock, connection removed 

Protect In01 0 
Protective interlock, connection 
removed 

Valve OpenAut - 

Open valve in automatic mode, 
(CIP_Supply\CIP 
SUPPLY.V3_OpenAut) 

Valve ModLiOp - 

Switch between operator/connection 
modes (CIP_Supply\CIP 
SUPPLY.V3_ModLiOp) 

Valve RstLi - 
Reset via the (CIP_Supply\CIP 
SUPPLY.V3_RstLi) connection 

Valve BatchEn - 
Occupation release (CIP_Supply\CIP 
SUPPLY.QBA_EN) 

Valve BatchID - 
Batch number (CIP_Supply\CIP 
SUPPLY.QBA_ID) 

Valve BatchName - 
Batch name (CIP_Supply\CIP 
SUPPLY.QBA_NA) 

Valve StepNo - 
Batch step number (CIP_Supply\CIP 
SUPPLY.QSTEP_NO) 

Valve Occupied - 
Occupied by batch (CIP_Supply\CIP 
SUPPLY.QOCCUPIED) 

Valve RdyToStart - 
Ready to start (CIP_Supply\CIP 
SUPPLY.V3_RdyToStart) 

Valve RdyToReset - 
Ready to reset (CIP_Supply\CIP 
SUPPLY.V3_RdyToReset) 

Valve Ctrl - 
Control output (CIP_Supply\CIP 
SUPPLY.V3_Ctrl) 

Valve AutAct - 
Automatic mode active 
(CIP_Supply\CIP SUPPLY.V3_AutAct) 

Valve FbkOpenOut - 
Valve open (CIP_Supply\CIP 
SUPPLY.V3_FbkOpenOut) 

Valve  FbkClosedOut - 
Valve closed (CIP_Supply\CIP 
SUPPLY.V3_FbkCloseOut) 
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YS_SupPreRinse 
The "YS_SupPreRinse" process tag controls the discharge from the fresh water 
tank into the supply inlet. The valve block receives the command to open or close 
from the "CIP SUPPLY" SFC type instance. The "YS_SupPreRinse" process tag 
is an instance of the "ValveLean" process tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–7 

Block Connection Value Usage 

FbkOpen PV_In 0 
Feedback message "Valve open", 
connection removed 

FbkClose PV_In 0 
Feedback message "Valve closed", 
connection removed 

Permit In01 0 
Release to open/close from the neutral 
position, connection removed 

Interlock In01 0 Interlock, connection removed 

Protect In01 0 
Protective interlock, connection 
removed 

Valve OpenAut - 

Open valve in automatic mode, 
(CIP_Supply\CIP 
SUPPLY.V1_OpenAut) 

Valve ModLiOp - 

Switch between operator/connection 
modes (CIP_Supply\CIP 
SUPPLY.V1_ModLiOp) 

Valve RstLi - 
Reset via the (CIP_Supply\CIP 
SUPPLY.V1_RstLi) connection 

Valve BatchEn - 
Occupation release (CIP_Supply\CIP 
SUPPLY.QBA_EN) 

Valve BatchID - 
Batch number (CIP_Supply\CIP 
SUPPLY.QBA_ID) 

Valve BatchName - 
Batch name (CIP_Supply\CIP 
SUPPLY.QBA_NA) 

Valve StepNo - 
Batch step number (CIP_Supply\CIP 
SUPPLY.QSTEP_NO) 

Valve Occupied - 
Occupied by batch (CIP_Supply\CIP 
SUPPLY.QOCCUPIED) 

Valve RdyToStart - 
Ready to start (CIP_Supply\CIP 
SUPPLY.V1_RdyToStart) 

Valve RdyToReset - 
Ready to reset (CIP_Supply\CIP 
SUPPLY.V1_RdyToReset) 

Valve Ctrl - 
Control output (CIP_Supply\CIP 
SUPPLY.V1_Ctrl) 

Valve AutAct - 
Automatic mode active 
(CIP_Supply\CIP SUPPLY.V1_AutAct) 

Valve FbkOpenOut - 
Valve open (CIP_Supply\CIP 
SUPPLY.V1_FbkOpenOut) 

Valve  FbkClosedOut - 
Valve closed (CIP_Supply\CIP 
SUPPLY.V1_FbkCloseOut) 
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4.2.2 CIP RETURN 

The temperature and concentration of the fluid are determined in the return line 
and, depending on the measured values, it is fed back into the CIP tanks. The 
valves to the tanks are opened depending on what the quality of the fluid is like. 
The fluid from the pre-rinse phase is fed directly into the drain. If the tanks are full 
or if the quality is not good enough, the fluid is also discharged into the drain. 

Design 
The figure below shows the design of the return apparatus: 
Figure 4–8 

CLt Return

 
The valves are controlled by an instance of the "CIP RETURN" SFC type. 
The following table provides you with an overview of the elements and process tag 
types used: 

Table 4–8 

Name Process tag type Description 

QIT_Return "AnalogMonitoring" Determining the alkali concentration 
TIT_Return "AnalogMonitoring" Determining the fluid temperature 
YS_RetDetergent "ValveLean" Valve for the return flow to the detergent tank 
YS_RetDrain "ValveLean" Valve for the return flow to the drain 
YS_RetPreRinse "ValveLean" Valve for the return flow to the pre-rinse tank 
CIP_Return SFC type instance • Opens and closes the valves 

• Interface for connecting to SIMATIC BATCH 
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The following figure shows schematically the return apparatus including the 
connections or SFC accesses that span the CFC diagram. 
 
Figure 4–9 
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Parameter assignment 
The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter 4.3.2, 
"Sequencers". 

QIT_Return 
The concentration of detergent in the fluid in the return line is determined in 
the "QIT_Return" process tag. This value is passed to the instance of the "CIP 
RETURN" SFC type. Based on the measured value, the controller decides which 
tank the fluid will be fed into. The "QIT_Return" process tag is an instance of 
the "AnalogMonitoring" process tag type. 
The following table shows the configuration of the instance from 
"AnalogMonitoring". 
Table 4–9 

Block Connection Value Usage 

Input1 PV_InUnit 1289 
Unit of measure of the measured 
quantity, millisiemens, mS 

Conductivity PV_Hyst 3.0 Hysteresis for the PV alarm 
Conductivity MsgLock 1 Suppress process messages 

Conductivity BatchEn - 
Occupation release (CIP_Return\CIP 
RETURN.QBA_EN) 

Conductivity BatchID - 
Batch number (CIP_Return\CIP 
RETURN.QBA_ID) 

Conductivity BatchName - 
Batch name (CIP_Return\CIP 
RETURN.QBA_ID) 

Conductivity StepNo - 
Batch step number (CIP_Return\CIP 
RETURN.QSTEP_NO) 

Conductivity Occupied - 
Occupied by batch (CIP_Return\CIP 
RETURN.QOCCUPIED) 
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TIT_Return 
The temperature of the fluid in the return line is determined in the "TIT_Return" 
process tag. This value is passed to the instance of the "CIP RETURN" SFC type. 
Based on the measured value, the controller decides which tank the fluid will be 
fed into. The "TIT_Return" process tag is an instance of the "AnalogMonitoring" 
process tag type. 
The following table shows the configuration of the instance from 
"AnalogMonitoring": 
Table 4–10 

Block Connection Value Usage 

Input1 PV_InUnit 1001 
Unit of measure of the measured 
quantity, degrees Celsius °C 

Temperature BatchEn - 
Occupation release (CIP_Return\CIP 
RETURN.QBA_EN) 

Temperature BatchID - 
Batch number (CIP_Return\CIP 
RETURN.QBA_ID) 

Temperature BatchName - 
Batch name (CIP_Return\CIP 
RETURN.QBA_ID) 

Temperature StepNo - 
Batch step number (CIP_Return\CIP 
RETURN.QSTEP_NO) 

Temperature Occupied - 
Occupied by batch (CIP_Return\CIP 
RETURN.QOCCUPIED) 

 

YS_RetDetergent 
The "YS_RetDetergent" valve process tag controls the return flow to the detergent 
tank. The process tag receives the command for opening or closing the valve from 
the instance of the "CIP RETURN" SFC type. The "YS_RetDetergent" valve 
process tag is an instance of the "ValveLean" process tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–11 

Block Connection Value Usage 

FbkOpen PV_In 0 
Feedback message "Valve open", 
connection removed 

FbkClose PV_In 0 
Feedback message "Valve closed", 
connection removed 

Permit In01 0 
Release to open or close from the 
neutral position, connection removed 

Interlock In01 0 Interlock, connection removed 

Protect In01 0 
Protective interlock, connection 
removed 

Valve OpenAut - 

Open valve in automatic mode, 
(CIP_Return\CIP 
RETURN.V2_OpenAut) 

Valve ModLiOp - 

Changeover of operating mode 
between operator and connection 
(CIP_Return\CIP 
RETURN.V2_ModLiOp) 
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Block Connection Value Usage 

Valve RstLi - 
Reset via the CIP_Return\CIP 
RETURN.V2_RstLi connection 

Valve BatchEn - 
Occupation release (CIP_Return\CIP 
RETURN.QBA_EN) 

Valve BatchID - 
Batch number (CIP_Return\CIP 
RETURN.QBA_ID) 

Valve BatchName - 
Batch name (CIP_Return\CIP 
RETURN.QBA_ID) 

Valve StepNo - 
Batch step number (CIP_Return\CIP 
RETURN.QSTEP_NO) 

Valve Occupied - 
Occupied by batch (CIP_Return\CIP 
RETURN.QOCCUPIED) 

Valve RdyToStart - 
Ready to start (CIP_Return\CIP 
RETURN.V2_RdyToStart) 

Valve RdyToReset - 
Ready to reset (CIP_Return\CIP 
RETURN.V2_RdyToReset) 

Valve Ctrl - 
Control output (CIP_Return\CIP 
RETURN.V2_Ctrl) 

Valve AutAct - 
Automatic mode active 
(CIP_Return\CIP RETURN.V2_AutAct) 

Valve FbkOpenOut - 
Valve open (CIP_Supply\CIP 
SUPPLY.V2_FbkOpenOut) 

Valve  FbkClosedOut - 
Valve closed (CIP_Return\CIP 
RETURN.V2_FbkCloseOut) 
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YS_RetDrain 
The "YS_RetDrain" valve process tag controls the return flow to the drain. 
The process tag receives the command for opening or closing the valve from 
the instance of the "CIP RETURN" SFC type. The "YS_RetDrain" valve process 
tag is an instance of the "ValveLean" process tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–12 

Block Connection Value Usage 

FbkOpen PV_In 0 
Feedback message "Valve open", 
connection removed 

FbkClose PV_In 0 
Feedback message "Valve closed", 
connection removed 

Permit In01 0 
Release to open/close from the neutral 
position, connection removed 

Interlock In01 0 Interlock, connection removed 

Protect In01 0 
Protective interlock, connection 
removed 

Valve OpenAut - 

Open valve in automatic mode, 
(CIP_Return\CIP 
RETURN.V3_OpenAut) 

Valve ModLiOp - 

Changeover of operating mode 
between operator and connection 
(CIP_Return\CIP 
RETURN.V3_ModLiOp) 

Valve RstLi - 
Reset via the CIP_Return\CIP 
RETURN.V3_RstLi connection 

Valve BatchEn - 
Occupation release (CIP_Return\CIP 
RETURN.QBA_EN) 

Valve BatchID - 
Batch number (CIP_Return\CIP 
RETURN.QBA_ID) 

Valve BatchName - 
Batch name (CIP_Return\CIP 
RETURN.QBA_ID) 

Valve StepNo - 
Batch step number (CIP_Return\CIP 
RETURN.QSTEP_NO) 

Valve Occupied - 
Occupied by batch (CIP_Return\CIP 
RETURN.QOCCUPIED) 

Valve RdyToStart - 
Ready to start (CIP_Return\CIP 
RETURN.V3_RdyToStart) 

Valve RdyToReset - 
Ready to reset (CIP_Return\CIP 
RETURN.V3_RdyToReset) 

Valve Ctrl - 
Control output (CIP_Return\CIP 
RETURN.V3_Ctrl) 

Valve AutAct - 
Automatic mode active 
(CIP_Return\CIP RETURN.V3_AutAct) 

Valve FbkOpenOut - 
Valve open (CIP_Supply\CIP 
SUPPLY.V3_FbkOpenOut) 

Valve  FbkClosedOut - 
Valve closed (CIP_Return\CIP 
RETURN.V3_FbkCloseOut) 
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YS_RetPreRinse 
The "YS_RetPreRinse" valve process tag controls the return flow to the pre-rinse 
tank. The process tag receives the command for opening or closing the valve from 
the instance of the "CIP RETURN" SFC type. The "YS_PreRinse" valve process 
tag is an instance of the "ValveLean" process tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–13 

Block Connection Value Usage 

FbkOpen PV_In 0 
Feedback message "Valve open", 
connection removed 

FbkClose PV_In 0 
Feedback message "Valve closed", 
connection removed 

Permit In01 0 
Release to open or close from the 
neutral position, connection removed 

Interlock In01 0 Interlock, connection removed 

Protect In01 0 
Protective interlock, connection 
removed 

Valve OpenAut  

Open valve in automatic mode, 
(CIP_Return\CIP 
RETURN.V1_OpenAut) 

Valve ModLiOp - 

Changeover of operating mode 
between operator and connection 
(CIP_Return\CIP 
RETURN.V1_ModLiOp) 

Valve RstLi - 
Reset via the CIP_Return\CIP 
RETURN.V1_RstLi connection 

Valve BatchEn - 
Occupation release (CIP_Return\CIP 
RETURN.QBA_EN) 

Valve BatchID - 
Batch number (CIP_Return\CIP 
RETURN.QBA_ID) 

Valve BatchName - 
Batch name (CIP_Return\CIP 
RETURN.QBA_ID) 

Valve StepNo - 
Batch step number (CIP_Return\CIP 
RETURN.QSTEP_NO) 

Valve Occupied - 
Occupied by batch (CIP_Return\CIP 
RETURN.QOCCUPIED) 

Valve RdyToStart - 
Ready to start (CIP_Return\CIP 
RETURN.V1_RdyToStart) 

Valve RdyToReset - 
Ready to reset (CIP_Return\CIP 
RETURN.V1_RdyToReset) 

Valve Ctrl - 
Control output (CIP_Return\CIP 
RETURN.V1_Ctrl) 

Valve AutAct - 
Automatic mode active 
(CIP_Return\CIP RETURN.V1_AutAct) 

Valve FbkOpenOut - 
Valve open (CIP_Return\CIP 
RETURN.V1_FbkOpenOut) 

Valve  FbkClosedOut - 
Valve closed (CIP_Return\CIP 
RETURN.V1_FbkCloseOut) 

 



4 Design and principle of operation 
 

 

CIP – Cleaning in Place 
V2.0, Entry ID: 78463886 33 
 


 S

ie
m

en
s 

AG
 2

01
5 

Al
l r

ig
ht

s 
re

se
rv

ed
 

4.2.3 Detergent tank 

The detergent tank contains the detergent used for cleaning. The detergent 
is heated to the required temperature in the tank. The required detergent 
concentration is also set. The detergent tank is continuously filled, either from 
the return line during the cleaning phases or by supplying fresh water and alkali. 
The temperature of the fluid in the tank is continuously regulated at a specified 
value. 

Design 
The figure below shows the design of the detergent tank: 
Figure 4–10 

Detergent Tank

 
 
The tank contains two level sensors which detect the maximum and minimum fill 
levels. The fluid is pumped via pipes through a heat exchanger in order to control 
the temperature. The concentration of the alkali is also measured in the pipes. 
The circulation of the fluid is controlled by means of an instance of the 
DETERGENT SFC type. This is also used to control the concentration and 
to pass the setpoints for the pid controller for temperature control. 
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The following table provides you with an overview of the elements and process tag 
types used: 

Table 4–14 

Name Process tag type Description 

QIT_Detergent "AnalogMonitoring" Process tag for the alkali concentration 
LIT_Detergent "AnalogMonitoring" Process tag for the fill level 
TIT_DetHeat "AnalogMonitoring" Process tag for the temperature of the fluid in the circuit 
TIT_Detergent "AnalogMonitoring" Process tag for the temperature of the fluid in the tank 
LSH_Detergent "DigitalMonitoring" Process tag for max. fill level reached 
LSL_Detergent "DigitalMonitoring" Process tag for min. fill level reached 
NS_DetCon "MotorLean" Process tag for activation of the pump to add detergent 
NS_DetHeat "MotorLean" Process tag for activation of the pump for the heating circuit 
YS_DetFreshWater "ValveLean" Process tag to control the valve for fresh water addition 
TIC_DetHeat "PIDControlLean" Process tag for controlling the fluid temperature 
PUPA_Det  Process tag for metering the addition of detergent 
DETERGENT  Instance of the "DETERGENT" SFC type 

 

Parameter assignment 
The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter 4.3.3, 
"Sequencers". 

QIT_Detergent 
The concentration of detergent in the fluid in the heating circuit is determined in 
the "QIT_Detergent" process tag. This value is passed to the instance of the 
"FILL_HEAT_CONC" SFC type. The supply of detergent in the tank is controlled 
on the basis of the measured value. The "QIT_Detergent" process tag is an 
instance of the "AnalogMonitoring" process tag type. 
The following table shows the configuration of the instance from 
"AnalogMonitoring": 
Table 4–15 

Block Connection Value Usage 

Input1 Scale 200 Scaling of the process value 

Input1 PV_InUnit 1289 
Unit of measure of the process value, 
millisiemens, mS 

Conductivity PV_Out  
Output of process value 
(DETERGENT\FHC.CONC_AI) 
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LIT_Detergent 
The current fill level of the detergent tank is measured in the "LIT_Detergent" 
process tag. The value is passed on to the instance of the "FILL_HEAT_CONC" 
SFC type. Based on this value, the fill level of the detergent tank is set. 
The "LIT_Detergent" process tag is an instance of the "AnalogMonitoring" 
process tag type. 
The following table shows the configuration of the instance from 
"AnalogMonitoring": 
Table 4–16 

Block Connection Value Usage 

Input1 Scale 25000 Scaling of the process value 

Input1 PV_InUnit 1038 
Unit of measure of the process value, 
liter, l 

Level - - MonAnL replaced by MonAnS 

Level PV_Out - 

Process value output 
(DETERGENT\FHC.LEVEL_AI, 
DETERGENT\FHC.L_HYS_AI) 

TIT_DetHeat 
The current temperature of the fluid in the heating circuit for the detergent tank 
is measured in the "TIT_DetHeat" process tag. The value is passed on to the 
instance of the "FILL_HEAT_CONC" SFC type. The temperature of the fluid in 
the detergent tank is regulated on the basis of this value. The "TIT_DetHeat" 
process tag is an instance of the "AnalogMonitoring" process tag type. 
The following table shows the configuration of the instance from 
"AnalogMonitoring": 
Table 4–17 

Block Connection Value Usage 

Temperature PV_Out - 
Process value output 
(TIC_DetHeat\PV.SimPV_IN) 

TIT_Detergent 
The current temperature of the fluid in the detergent tank is measured in the 
"TIT_Detergent" process tag. The value is passed on to the instance of the 
"FILL_HEAT_CONC" SFC type. The temperature of the fluid in the detergent 
tank is regulated on the basis of this value. The "TIT_Detergent" process tag is 
an instance of the "AnalogMonitoring" process tag type. 
The following table shows the configuration of the instance from 
"AnalogMonitoring": 
Table 4–18 

Block Connection Value Usage 

Temperature PV_Out - 
Output of process value 
(DETERGENT\FHC.TEMP_AI) 
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LSH_Detergent 
The upper fill level limit of the detergent tank is monitored in the "LSH_Detergent" 
process tag. The value is passed on to the instance of the "FILL_HEAT_CONC" 
SFC type. This is used to regulate the fill level in the detergent tank. The 
"LSH_Detergent" process tag is an instance of the "DigitalMonitoring" process 
tag type. 
The following table shows the configuration of the instance from 
"DigitalMonitoring": 
Table 4–19 

Block Connection Value Usage 

MonDigital In - 
Digital input value 
(DETERGENT\FHC.LS1_In) 

MonDigital Out - 
Digital output value 
(YS_DetFreshWater\Permit.In02) 

LSL_Detergent 
The lower fill level limit of the detergent tank is monitored in the "LSL_Detergent" 
process tag. The value is passed on to the instance of the "FILL_HEAT_CONC" 
SFC type. This is used to regulate the fill level in the detergent tank. The 
"LSL_Detergent" process tag is an instance of the "DigitalMonitoring" process 
tag type. 
The following table shows the configuration of the instance from 
"DigitalMonitoring": 
Table 4–20 

Block Connection Value Usage 

MonDigital In - 
Digital input value 
(DETERGENT\FHC.LS2_In) 

MonDigital Out - 
Digital output value 
(NS_DetHeat\Protect.In01) 
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YS_DetFreshWater 
The "YS_DetFreshWater" valve process tag controls the supply of fresh water 
to the detergent tank. The process tag receives the command for opening or 
closing the valve from the instance of the "FILL_HEAT_CONC" SFC type. 
The "YS_DetFreshWater" process tag is an instance of the "ValveLean" process 
tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–21 

Block Connection Value Usage 

Valve OpenAut - 
Valve open in automatic mode 
(DETERGENT\FHC.V1_OpenAut) 

Valve CloseAut - 
Valve closed in automatic mode 
(DETERGENT\FHC.V1_CloseAut) 

Valve ModLiOp - 
Switching between operator/connection 
(DETERGENT\FHC.V1_ModLiOP) 

Valve AutModLi - 
Automatic mode via connection 
(DETERGENT\FHC.V1AutModLi) 

Valve ManModLi - 

Manual operation via connection, 
inverted 
(DETERGENT\FHC.V1_AutModLi) 

Valve Ctrl - 
Control output 
(DETERGENT\FHC.V1_Ctrl) 

Valve AutAct - 
Automatic mode is active 
(DETERGENT\FHC.V1_AutAct) 

Valve FbkOpenOut - 
Feedback message "Valve open" 
(DETERGENT\FHC.V1_FbkOpenOut) 

Valve FbkCloseOut - 
Feedback message "Valve closed" 
(DETERGENT\FHC.V1_FbkCloseOut) 
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NS_DetCon 
The "NS_DetCon" motor process tag is used for metering the detergent supply. 
The motor is pulse-driven from the "PUPA_Det" process tag. The "NS_DetCon" 
motor process tag is an instance of the "MotorLean" process tag type. 
The following table shows the configuration of the instance from "MotorLean": 
Table 4–22 

Block Connection Value Usage 

Motor StartAut - 
Starting the motor in automatic mode 
(NS_DetCon\2.Out) 

Motor StopAut - 
Stopping the motor in automatic mode 
(NS_DetCon\3.Out) 

Motor ModLiOP - 
Switching between operator/connection 
(DETERGENT\FHC.M2_ModLiOP) 

Motor Start - 
Activating the motor, "Start" 
(DETERGENT\FHC.M2_Start) 

Motor FbkRunOut - 
Feedback message for "Start" 
(DETERGENT\FHC.M2_FbkRunOut) 

Or04 - - Added as "2" to start the motor 

2 In01 - 
Pulsed starting of the motor 
(PUPA_Det\STRENGT.ActGrp01) 

2 In02 - 
Starting the motor 
(DETERGENT\FHC.M2_StartAut) 

Or04 - - Added as "3" to stop the motor 

3 In01 - 
Pulsed starting of the motor, inverted 
(PUPA_Det\STRENGT.ActGrp01) 

3 In02 - (DETERGENT\FHC.M2_StopAut) 
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NS_DetHeat 
The "NS_DetHeat" motor process tag is used to activate the pump for the heating 
circuit. The process tag receives the command for starting and stopping the motor 
from the instance of the "FILL_HEAT_CONC" SFC type. The motor process tag 
is an instance of the "MotorLean" process tag type. 
The following table shows the configuration of the instance from "MotorLean": 
Table 4–23 

Block Connection Value Usage 

Motor StartAut - 
Starting the motor in automatic mode 
(DETERGENT\FHC.M1_StartAut) 

Motor AutModLi - 
Automatic mode via connection 
(DETERGENT\FHC.M1_AutModLi) 

Motor ManModLi - 

Manual operation via connection, 
inverted 
(DETERGENT\FHC.M1_AutModLi) 

Motor ModLiOP - 
Switching between operator/connection 
(DETERGENT\FHC.M1_ModLiOP) 

Motor start - 
Activating the motor, "Start" 
(DETERGENT\FHC.M1_Start) 

Motor FbkRunOut  
Feedback message for "Start" 
(DETERGENT\FHC.M1_FbkRunOut) 

Protect In01 - Inverted 
Protect In02 1 - 

 

TIC_DetHeat 
The temperature of the fluid is determined in the "TIC_DetHeat" process tag. 
The setpoint is specified via the instance of the "FILL_HEAT_CONC" SFC type. 
The process tag passes the control variable to the "YC_DetHeat" valve process 
tag. The process tag is an instance of the "PIDControlLean" process tag type. 
The following table shows the configuration of the instance from "PIDControlLean": 
Table 4–24 

Block Connection Value Usage 

PID SP_LiOp - 
Setpoint source internal/external 
(DETERGENT\FHC.PID1_SP_LiOP) 

PID ModLiOp - 

Switchover of operating mode, 
operator/automatic 
(DETERGENT\FHC.PID1_ModLiOp) 

PID AutAct - 

Automatic mode active 
(DETERGENT\PID1_AutAct) 
 

PID LoopClosed - 
Control loop closed 
(DETERGENT\FHC.PID1_LoopClosed) 

PID PV_Out - 
Process value output 
(DETERGENT\FHC.PID1_PV_Out) 

PV SimOn 1 Simulation switched on 

PV SimPV_In - 
Simulated process value 
(TIT_DetHeat\Temperature.PV_Out) 
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PUPA_Det 
The "PUPA_Det" process tag is used for pulsed activation. The process tag 
receives the start command for activation from the instance of the 
"FILL_HEAT_CONC" SFC type. The "PUPA_Det" process tag passes the pulsed 
control command on to the "NS_DetCon" motor process tag. 
The following table shows the configuration of the process tag: 
Table 4–25 

Block Connection Value Usage 

BlPuPa - - 
Inserted as "STRENGTH" for 
pulse/pause function 

STRENGTH ModLiOp - 

Switchover between operating modes 
operator/automatic 
(DETERGENT\FHC.PUPA1_ModLiOp) 

STRENGTH AutModLi - 
Automatic mode via connection 
DETERGENT\FHC.PUPA1_AutModLi 

STRENGTH ManModLi - 
Manual operation via connection 
DETERGENT\FHC.PUPA1_ManModLi 

STRENGTH StartAut - 
Start signal in automatic mode 
(DETERGENT\FHC.PUPA1_StartAut) 

STRENGTH IntLock 1 Valve interlocked (1= no) 
STRENGTH GroupCnt 1 Number of activated groups 
STRENGTH LoopCnt 8 Reiterations of activated groups 
STRENGTH Pulse01 5.0 Pulse duration for Group 1 

STRENGTH AutAct - 
Automatic mode active 
(DETERGENT\FHC.PUPA1_AutAct) 

STRENGTH ManAct - 
Manual operation active 
(DETERGENT\FHC.PUPA1_ManAct) 

STRENGTH StartOut - 
Status of signal 
(DETERGENT\FHC.PUPA1_StartOut) 

STRENGTH ActiveOut - 
Status of reiteration 
(DETERGENT\FHC.PUPA1_ActiveOut) 

STRENGTH ActGrp01 - 

Activated device group 
(DETERGENT\FHC.PUPA1_ActGrp01, 
NS_DetCon\2.In1, NS_DetCon\3.In1)  

STRENGTH CurLpCnt - 
Current reiteration 
(DETERGENT\FHC.PUPA1_CurLpCnt) 

STRENGTH AllLpDone - 

All reiterations satisfied 
(DETERGENT\FHC.PUPA1_AllLpDone, 
DETERGENT\FHC.SIG_2) 
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4.2.4 Fresh water tank (post rinse tank) 

Fresh water for post-rinsing is stored in the fresh water tank It is drawn off during 
the post-rinse phase. No water is fed into this tank from the return line. The water 
is not reprocessed and can be used at ambient temperature. Fluid can be drawn 
from the fresh water tank at any time, provided the level does not fall below the 
minimum fill level. 

Design 
The figure below shows the design of the fresh water tank: 
Figure 4–11 

Freshwater Tank

 
 
In the "CIP" application example, the process tags for the fresh water tank are only 
partially included. Furthermore, the included process tags are not functional and 
are provided for demonstration purposes. 
The design depends strongly on the requirements of the cleaning process. 
The detergent tank (process tags and "FILL_HEAT_CONC" SFC type) can be 
taken as a template for configuration. The elements that are not needed can be 
removed. In the application example, only the "LSH_PostRinse" process tag is 
included. The "LSH_PostRinse" process tag is an instance of the 
"DigitalMonitoring" process tag type. 
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4.2.5 Pre rinse tank 

The fluid for pre rinsing is stored and reprocessed in the pre rinse tank. It is drawn 
off during the pre rinse phase. Fluid can be fed into the tank via the return line. 
It is also possible to supply fresh water. 

Design 
The figure below shows the design of the pre rinse tank: 
Figure 4–12 

tre rinse Tanke

 
 
In the "CIP" application example, the process tags for the pre rinse tank are only 
partially included. The reprocessing of the fluid (e.g., temperature) is not 
considered. 
The design of the pre rinse tank depends strongly on the requirements of the 
cleaning process. The detergent tank (process tags and "FILL_HEAT_CONC" 
SFC type) can be taken as a template for configuration. The elements that are 
not needed can be removed. In the application example, only the "LSH_PreRinse" 
process tag is included. The "LSH_PreRinse" process tag is an instance of the 
"DigitalMonitoring" process tag type. 
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Parameter assignment 
The parameter assignment for the individual process tags is described in the 
following. 

LSH_PreRinse 
The maximum fill level of the pre rinse tank is monitored in the "LSH_PreRinse" 
process tag. The value is passed on to the instance of the "CIP RETURN" 
SFC type. This is used to regulate the fill level in the pre rinse tank. The 
"LSH_PreRinse" process tag is an instance of the "DigitalMonitoring" process tag 
type. 
The following table shows the configuration of the instance from 
"DigitalMonitoring": 
Table 4–26 

Block Connection Value Usage 

LSH03 In - 
Digital input value  
(CIP_Return\CIP RETURN.LS2_In) 

LSH03 Out - 
Digital output value  
(CIP_Return\CIP RETURN.LS2_Out) 

 

4.2.6 Mixer 

The mixer is the part of the plant to be cleaned in the "CIP" application example 
and is used to demonstrate the process. There are no process tags configured 
for the mixer in the application example. 

Design 
The figure below shows the design of the mixer: 
Figure 4–13 

Mixer
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4.2.7 Mixer supply (TANK_IN) 

The cleaning fluid is fed from the CIP system into the mixer via the supply line. 
Furthermore, an additional valve is cleaned. The additional valve is controlled 
by an instance of the BlPuPa block. 

Design 
The figure below shows the design of the mixer supply: 
Figure 4–14 

Tank Ln

 
The valves are controlled by an instance of the "TANK_IN" SFC type. 
The following table provides you with an overview of the elements and process tag 
types used: 

Table 4–27 

Name Process tag type Description 

TANK_IN Instance of 
"TANK_IN" SFC 
type 

Control of valves in supply to mixer 

PUPA_Mixer Instance of BlPuPa 
function block 

Pulsed control of additional valve 

YS_TankInMix "ValveLean" Valve for the supply to the mixer 
YS_TankInDrain "ValveLean" Additional valve 
LSH_Mixer "DigitalMonitoring" Process tag for max. fill level reached 

 

Parameter assignment 
The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter 4.3 
"Sequencers". 
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PuPa_Mixer 
The "PUPA_Mixer" process tag is used for pulsed activation. The process tag 
receives the start command for activation from the instance of the "TANK_IN" 
SFC type. The "PUPA_Mixer" process tag passes the pulsed control command 
on to the "YS_TankInMix" valve process tag. 
The following table shows the configuration of the process tag: 
Table 4–28 

Block Connection Value Usage 

BlPuPa - - Inserted as "BlPuPa" for pulse/pause function 

BlPuPa ModLiOp - 

Switchover of operating mode, 
operator/automatic 
(TANK_IN\MX_TANK_IN.PUPA_ModLiOp) 

BlPuPa AutModLi - 
Automatic mode via connection 
TANK_IN\MX_TANK_IN.PUPA_AutModLi 

BlPuPa ManModLi - 
Manual operation via connection 
TANK_IN\MX_TANK_IN.PUPA_ManModLi 

BlPuPa StartAut - 
Start signal in automatic mode 
(TANK_IN\MX_TANK_IN.PUPA_StartAut) 

BlPuPa IntLock 1 Valve interlocked (1= no) 
BlPuPa GroupCnt 1 Number of activated groups 

BlPuPa LoopCnt 8 
Reiterations of activated groups 
(TANK_IN\MX_TANK_IN.PUPA_LoopCnt) 

BlPuPa Pulse01 5.0 Pulse duration for Group 1 

BlPuPa AutAct - 
Automatic mode active 
(TANK_IN\MX_TANK_IN.PUPA_AutAct) 

BlPuPa ManAct - 
Manual operation active 
(TANK_IN\MX_TANK_IN.PUPA_ManAct) 

BlPuPa StartOut - 
Status of signal 
(TANK_IN\MX_TANK_IN.PUPA_StartOut) 

BlPuPa ActiveOut - 
Status of reiteration 
(TANK_IN\MX_TANK_IN.PUPA_ActiveOut) 

BlPuPa ActGrp01 - 

Activated device group 
(TANK_IN\MX_TANK_IN.PUPA__ActGrp01, 
YS_TankInDrain\1.In1)  

BlPuPa CurLpCnt - 
Current reiteration 
(TANK_IN\MX_TANK_IN.PUPA_CurLpCnt) 

BlPuPa AllLpDone - 
All reiterations satisfied 
(TANK_IN\MX_TANK_IN.PUPA_AllLpDone,) 

BlPuPa OvwBatchInfo 1 CMData can be overwritten with BATCH data  

BlPuPa BatchEnLi - 
Occupation release 
TANK_IN\MX_TANK_IN.PUPA_QBA_EN 

BlPuPa BatchOccLi - 
Occupied by batch 
TANK_IN\MX_TANK_IN.PUPA_QOCCUPIED 

BlPuPa BatchIdLi - 
Batch number 
TANK_IN\MX_TANK_IN.PUPA_QBA_ID 

BlPuPa BatchNameLi - 
Batch name 
TANK_IN\MX_TANK_IN.PUPA_QBA_NA 

BlPuPa StepNoLi - 
Batch step number 
TANK_IN\MX_TANK_IN.PUPA_QSTEP_NO 
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LSH_Mixer 
The maximum fill level of the mixer is monitored in the "LSH_Mixer" process tag. 
The "LSH_MIXER" process tag is an instance of the "DigitalMonitoring" process 
tag type. In the "CIP" application example, the process tag is used for 
demonstration purposes and has no function. No changes have been made to 
the process tag type. 

YS_TankInMix 
The "YS_ TankInMix" valve process tag controls the supply from the CIP system to 
the mixer. The process tag receives the command for opening or closing the valve 
from the instance of the "TANK_IN" SFC type. The "YS_ TankInMix" valve process 
tag is an instance of the "ValveLean" process tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–29 

Block Connection Value Usage 

FbkOpen PV_In 0 
Feedback message "Valve open", 
connection removed 

FbkClose PV_In 0 
Feedback message "Valve closed", 
connection removed 

Permit In01 0 
Release to open or close from the neutral 
position, connection removed 

Interlock In01 0 Interlock, connection removed 
Protect In01 0 Protective interlock, connection removed 

Valve OpenAut - 
Open valve in automatic mode, 
(TANK_IN\MX_TANK_IN.V1_OpenAut) 

Valve ModLiOp - 

Switchover of operating mode between 
operator/automatic 
(TANK_IN\MX_TANK_IN.V1_ModLiOp) 

Valve RstLi - 
Reset via connection 
TANK_IN\MX_TANK_IN.V1_RstLi 

Valve BatchEn - 
Occupation release 
(TANK_IN\MX_TANK_IN.QBA_EN) 

Valve BatchID - 
Batch number 
(TANK_IN\MX_TANK_IN.QBA_ID) 

Valve BatchName - 
Batch name 
(TANK_IN\MX_TANK_IN.QBA_NA) 

Valve StepNo - 
Batch step number 
(TANK_IN\MX_TANK_IN.QSTEP_NO) 

Valve Occupied - 
Occupied by batch 
(TANK_IN\MX_TANK_IN.QOCCUPIED) 

Valve RdyToStart - 
Ready to start 
(TANK_IN\MX_TANK_IN.V1_RdyToStart) 

Valve RdyToReset - 
Ready to reset 
(TANK_IN\MX_TANK_IN.V1_RdyToReset) 

Valve Ctrl - 
Control output 
(TANK_IN\MX_TANK_IN.V1_Ctrl) 

Valve AutAct - 
Automatic mode active 
(TANK_IN\MX_TANK_IN.V1_AutAct) 
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Block Connection Value Usage 

Valve FbkOpenOut - 
Valve open 
(TANK_IN\MX_TANK_IN.V1_FbkOpenOut) 

Valve  FbkClosedOut - 
Valve closed 
(TANK_IN\MX_TANK_IN.V1_FbkCloseOut) 

 

YS_TankInDrain 
The "YS_ TankInDrain" valve process tag controls an additional valve, leading to 
the drain, in the supply from the CIP system to the mixer. The process tag receives 
the command for opening or closing the valve from the instance of the "TANK_IN" 
SFC type and the "PuPa_Mixer" process tag. The "YS_TankInDrain" process tag 
is an instance of the "ValveLean" process tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–30 

Block Connection Value Usage 

FbkOpen PV_In 0 
Feedback message "Valve open", 
connection removed 

FbkClose PV_In 0 
Feedback message "Valve closed", 
connection removed 

Permit In01 0 
Release to open or close from the neutral 
position, connection removed 

Interlock In01 0 Interlock, connection removed 
Protect In01 0 Protective interlock, connection removed 

Or04 - - 
Inserted as "1" to open the valve via the 
SFC or the PuPa 

1 In1 - 
Open using the PuPa 
(PuPa_Mixer\BIPuPa.ActGrp01) 

1 In2 - 
Open using the SFC 
(TANK_IN\MX_TANK_IN.2_OpenAut) 

1 Out - (TANK_IN\YS_TankInDrain\Valve.OpenAut) 

Valve AutModLi - 
Automatic mode via connection 
TANK_IN\MX_TANK_IN.V2_AutModLi 

Valve ModLiOp - 

Switchover of operating mode between 
operator/connection 
(TANK_IN\MX_TANK_IN.V2_ModLiOp) 

Valve RstLi - 
Reset via connection 
TANK_IN\MX_TANK_IN.V2_RstLi 

Valve BatchEn - 
Occupation release 
(TANK_IN\MX_TANK_IN.QBA_EN) 

Valve BatchID - 
Batch number 
(TANK_IN\MX_TANK_IN.QBA_ID) 

Valve BatchName - 
Batch name 
(TANK_IN\MX_TANK_IN.QBA_NA) 

Valve StepNo - 
Batch step number 
(TANK_IN\MX_TANK_IN.QSTEP_NO) 

Valve Occupied - 
Occupied by batch 
(TANK_IN\MX_TANK_IN.QOCCUPIED) 

Valve RdyToStart - 
Ready to start 
(TANK_IN\MX_TANK_IN.V2_RdyToStart) 
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Block Connection Value Usage 

Valve RdyToReset - 
Ready to reset 
(TANK_IN\MX_TANK_IN.V2_RdyToReset) 

Valve Ctrl - 
Control output 
(TANK_IN\MX_TANK_IN.V2_Ctrl) 

Valve AutAct - 
Automatic mode active 
(TANK_IN\MX_TANK_IN.V2_AutAct) 

Valve FbkOpenOut - 
Valve open 
(TANK_IN\MX_TANK_IN.V2_FbkOpenOut) 

Valve  FbkClosedOut - 
Valve closed 
(TANK_IN\MX_TANK_IN.V2_FbkCloseOut) 

 

4.2.8 Mixer discharge (TANK_OUT) 

From the discharge outlet, the cleaning fluid is fed from the mixer back into the 
CIP system or into the drain.  

Design 
The figure below shows the design of the mixer discharge: 
Figure 4–15 

Tank hut

 
The valve and the pump are controlled by an instance of the "TANK_OUT" 
SFC type. 
The following table provides you with an overview of the elements and process tag 
types used: 

Table 4–31 

Name Process tag type Description 

TANK_Out Instance of 
"TANK_IN" SFC type 

Control of the valve and pump in the mixer discharge outlet 

LSL_Mixer "DigitalMonitoring" Process tag for min. fill level reached 
YS_TankOutMix "ValveLean" Valve for the mixer discharge outlet 
NS_Mixer "MotorLean" Pump for the mixer discharge outlet 
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Parameter assignment 
The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter 4.3.5 
"Sequencers". 

LSL_Mixer 
In the "LSL_Mixer" process tag, the fill level of the mixer is monitored to ensure 
that the minimum value has not been reached. The "LSL_MIXER" process tag is 
an instance of the "DigitalMonitoring" process tag type. In the "CIP" application 
example, the process tag is used for demonstration purposes and has no function. 
No changes have been made to the process tag type. 

NS_Mixer 
The "NS_Mixer" motor process tag is used for emptying the mixer. The motor is 
controlled by an instance of the "TANK_OUT" SFC type. The "NS_Mixer" motor 
process tag is an instance of the "MotorLean" process tag type. 
The following table shows the configuration of the instance from "MotorLean": 
Table 4–32 

Block Connection Value Usage 

Permit In01 - Connection removed 
Interlock In01 - Connection removed 
Protect In01 - Connection removed 

Motor StartAut - 
Starting the motor in automatic mode 
(TANK_OUT\MX_TANK_OUT.M1_StartAut) 

Motor ModLiOp - 

Switchover of operating mode between 
operator and connection 
(TANK_OUT\MX_TANK_OUT.M1_ModLiOp) 

Motor AutModLi - 
Automatic mode via connection 
TANK_OUT\MX_TANK_OUT.M1_AutModLi 

Motor BatchEn - 
Occupation release 
(TANK_OUT\MX_TANK_OUT.QBA_EN) 

Motor BatchID - 
Batch number 
(TANK_OUT\MX_TANK_OUT.QBA_ID) 

Motor BatchName - 
Batch name 
(TANK_OUT\MX_TANK_OUT.QBA_NA) 

Motor StepNo - 
Batch step number 
(TANK_OUT\MX_TANK_OUT.QSTEP_NO) 

Motor Occupied - 
Occupied by batch 
(TANK_OUT\MX_TANK_OUT.QOCCUPIED) 

Motor Start - 
Activating the motor, "Start" 
(TANK_OUT\MX_TANK_OUT.M1_Start) 

Motor FbkRunOut - 
Feedback message for "Start" 
(TANK_OUT\MX_TANK_OUT.M1_FbkRunOut) 
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YS_TankOutMix 
The "YS_TankOutMix" valve process tag controls the flow of the cleaning fluid from 
the mixer back into the CIP system. The process tag receives the command for 
opening or closing the valve from the instance of the "TANK_OUT" SFC type. The 
"YS_TankInDrain" process tag is an instance of the "ValveLean" process tag type. 
The following table shows the configuration of the instance from "ValveLean": 
Table 4–33 

Block Connection Value Usage 

Valve OpenAut - 
"Valve open" in automatic mode 
(TANK_OUT\MX_TANK_OUT.V1_OpenAut) 

Valve CloseAut - 
"Valve closed" in automatic mode 
(TANK_OUT\MX_TANK_OUT.V1_CloseAut) 

Valve ModLiOp - 

Switchover of operating mode between operator 
and connection 
(TANK_OUT\MX_TANK_OUT.V1_ModLiOp) 

Valve AutModLi - 
Automatic mode via connection 
TANK_OUT\MX_TANK_OUT.V1_AutModLi 

Valve Ctrl - 
Control output 
(TANK_OUT\MX_TANK_OUT.V1_Ctrl) 

Valve FbkOpenOut - 
Feedback message "Valve open" 
(TANK_OUT\MX_TANK_OUT.V1_FbkOpenOut) 

Valve FbkCloseOut - 
Feedback message "Valve closed" 
(TANK_OUT\MX_TANK_OUT.V1_FbkCloseOut) 

Valve GrpErr - 
Group error is "active" 
(TAN_OUT\MX_TANK_OUT.V1_GrpErr) 

Valve BatchEn - 
Occupation release 
(TANK_OUT\MX_TANK_OUT.QBA_EN) 

Valve BatchID - 
Batch number 
(TANK_OUT\MX_TANK_OUT.QBA_ID) 

Valve BatchName - 
Batch name 
(TANK_OUT\MX_TANK_OUT.QBA_NA) 

Valve StepNo - 
Batch step number 
(TANK_OUT\MX_TANK_OUT.QSTEP_NO) 

Valve Occupied - 
Occupied by batch 
(TANK_OUT\MX_TANK_OUT.QOCCUPIED) 
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4.3 Sequencers (SFC type instances) 
The CIP system is designed for batch operation. Within the system there are 
various SFC type instances with various tasks. According to ISA 88, the SFC type 
instance describes the equipment module. These will be described in the following 
sections. 
The SFC types for the "CIP" example application are summarized in the following 
table: 
Table 4–34 

SFC type name Comment 

CIP RETURN The return line for the CIP system 
CIP SUPPLY The supply line for the CIP system 
FILL_HEAT_CONC The reprocessing of the fluid (no SIMATIC 

BATCH functionality) 

 

4.3.1 CIP RETURN 

The SFC type instance is started by SIMATIC BATCH in the cleaning recipes and 
opens or closes the valves in the return line of the CIP system which lead to the 
tanks and the drain. This takes place according to the selected control strategy 
(defined in the recipe) and the quality of the fluid. 

Control strategies 
The control strategies for the "CIP RETURN" SFC type are summarized in the 
following table: 
Table 4–35 

Control strategy name Comment 

PRE RINSE Control strategy for pre rinse phase 
DETERGENT Control strategy for wash phase 
POST RINSE Control strategy for post rinse phase 
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Setpoints 
The setpoints for the "CIP RETURN" SFC type are summarized in the following 
table: 
Table 4–36 

Setpoint name Data 
type 

I/O name Units Comment 

TEMP_RINSE REAL PRE_TEMP °C Temperature of pre 
rinse fluid 

TEMP_DETERGENT REAL DET_TEMP °C Temperature of 
washing fluid 

HYSTERESIS_TEMP REAL T_HYS °C Temperature 
hysteresis 

PRE_CONC REAL PRE_CONC mS Detergent 
concentration in pre 
rinse fluid 

DET_CONC REAL DET_CONC mS Detergent 
concentration in 
washing fluid 

HYSTERESIS REAL C_HYS mS Concentration 
hysteresis 

Process values 
The process values for the "CIP RETURN" SFC type are summarized in the 
following table: 
Table 4–37 

Process value 
name 

Data type I/O name Comment 

TEMP_PRE_SUB REAL TEMP_PRE_SUB Temperature of pre rinse fluid 
TEMP_DET_SUB REAL TEMP_DET_SUB Temperature of washing fluid 
CONC_PRE_SUB REAL CONC_PRE_SUB Detergent concentration in pre 

rinse fluid 
CONC_DET_SUB REAL CONC_DET_SUB Detergent concentration in 

washing fluid 

Block contacts 
The block contacts for the "CIP RETURN" SFC type are summarized in the 
following table: 
Table 4–38 

Name Block I/O name Comment 

V1 VlvL V1 Valve to pre rinse 
tank 

V2 VlvL V2 Valve to detergent 
tank 

V3 VlvL V3 Valve to the drain 
LS1 MonDiL LS1 Level monitoring in 

pre rinse tank 
LS2 MonDiL LS2 Level monitoring in 

detergent tank 
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Sequencers 
The following sequencers are configured in the "CIP RETURN" SFC type: 
• PRE RINSE Switches all valves to automatic mode, closes the valves to the 

tanks, opens the valve to the drain. 
• DETERGENT: Switches all valves to automatic mode, opens the valves to the 

relevant tanks and closes the valve to the drain. Opens the valve to the drain 
if the tanks are full or if the fluid is not OK. 

• POST RINSE: see DETERGENT 
• COMPLETING_ABORT: Closes all valves and enables them for manual 

operation once again. 

COMPLETING_ABORT 
The "COMPLETING_ABORT" sequence closes all valves and enables them for 
manual operation and sets the SFC in the "IDLE" state. 
The start conditions for the "COMPLETING_ABORT" sequence are summarized 
in the following table: 
Table 4–39 

SFC status = Value Logic 

ABORTING = Aborting 
OR 

COMPLETING = Completing 

 
The design of the "COMPLETING_ABORT" sequence is summarized in the 
following table: 
Figure 4–16 
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PRERINSE 
The "PRERINSE" sequence performs the following actions in the pre rinse phase: 
• Sets valves in the return line to automatic mode 
• Closes all the valves to the tanks 
• Opens the valve to the drain 
• Sets the SFC to the "Ready to Complete" state at the end of processing 
The start conditions for the "PRERINSE" sequence are summarized in the 
following table: 
Table 4–40 

SFC status = Value Logic 

Run = Run 
AND QCS = 1 

READY_TC = 0 

 
The sequencer remains active until it is terminated by the higher level controller 
(SIMATIC BATCH). 
The design of the "PRERINSE" sequencer is summarized in the following table: 
Figure 4–17 

Rücksetzen aller Ventile im 
Rücklauf über Verschaltung
Betrieb über Verschaltung

Start

Einschalt-
bereitschaft 

liegt vor?

Be
tr

ie
bs

ar
te

nu
m

sc
ha

ltu
ng

 fü
r a

lle
 V

en
til

e 
in

 A
ut

om
at

ik
,

Ve
nt

ile
 zu

 d
en

 T
an

ks
 sc

hl
ie

ße
n 

un
d 

Ve
nt

il 
zu

m
 K

an
al

 ö
ffn

en

PR
ER

IN
SE

Alle Ventile in 
Automatikbetrieb

Alle Ventile 
im 

Automatik-
betrieb?

Ende

Ventil zum Kanal öffnen

Ventil 
geöffnet?

ja

ja

ja

ja

 



4 Design and principle of operation 
 

 

CIP – Cleaning in Place 
V2.0, Entry ID: 78463886 55 
 


 S

ie
m

en
s 

AG
 2

01
5 

Al
l r

ig
ht

s 
re

se
rv

ed
 

DETERGENT 
The "DETERGENT" sequencer performs the following actions in the wash phase: 
• Sets valves in the return line to automatic mode 
• Opens or closes the valves depending on the fill levels in the tanks and the 

quality of the fluid 
• Sets the SFC to the "Ready to Complete" state (in each "valve step") 
There is a separate step ("valve step") for each valve that is opened or closed. 
In this step, the corresponding valve is opened and all other valves are closed. 
In the subsequent transition, a check is made to see whether the conditions have 
changed. If the conditions have changed, the sequencer jumps accordingly to 
another valve step. 
The start conditions for the "DETERGENT" sequencer are summarized in the 
following table: 
Table 4–41 

SFC status = Value Logic 

RUN = Run 
AND QCS = 2 

READY_TC = 0 

 
The sequencer remains active until it is terminated by the higher level controller 
(SIMATIC BATCH). 
The design of the "DETERGENT" sequencer is summarized in the following figure: 
Figure 4–18 
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POSTRINSE 
The "POSTRINSE" sequencer performs the following actions in the post rinse 
phase: 
• Sets valves in the return line to automatic mode 
• Opens or closes the valves depending on the fill levels in the tanks and the 

quality of the fluid 
• Sets the SFC to the "Ready to Complete" state (in each "valve step") 
There is a separate step ("valve step") for each valve that is opened or closed. 
In this step, the corresponding valve is opened and all other valves are closed. 
In the subsequent transition, a check is made to see whether the conditions have 
changed. If the conditions have changed, the sequencer jumps accordingly to 
another valve step. 
The start conditions for the "POSTRINSE" sequencer are summarized in the 
following table: 
Table 4–42 

SFC status = Value Logic 

RUN = Run 
AND QCS = 3 

READY_TC = 0 

 
The sequencer remains active until it is terminated by the higher level controller 
(SIMATIC BATCH). 
The design of the "POSTRINSE" sequencer is identical to that of the 
"DETERGENT" sequencer. 
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4.3.2 CIP SUPPLY 

The SFC type instance is started by SIMATIC BATCH in the cleaning recipes and 
opens or closes the valves from the tanks of the CIP system which lead to the 
supply line. This takes place according to the selected control strategy (defined 
in the recipe). In addition, a pump is started to pump the fluid from the tanks into 
the plant sections that are to be cleaned. Before the fluid is drawn from the tanks, 
a check is made to ensure that the relevant conditions are satisfied.  

Control strategies 
The control strategies for the "CIP SUPPLY" SFC type are summarized in the 
following table: 
Table 4–43 

Control strategy name Comment 

PRERINSE Control strategy for pre rinse phase 
DETERGENT Control strategy for wash phase 
POSTRINSE Control strategy for post rinse phase 

 

Setpoints 
The control strategies for the "CIP SUPPLY" SFC type are summarized in the 
following table: 
Table 4–44 

Setpoint name Data 
type 

I/O name Units Comment 

RINSE_TIME REAL RINSE_TIME s Duration of rinsing in 
the phase 

RINSE_FLOW REAL RINSE_FLOW m³/h Flow rate 

 

Process values 
The process values for the "CIP SUPPLY" SFC type are summarized in the 
following table: 
Table 4–45 

Process value name Data 
type 

I/O name Comment 

PRERINSE_READY BOOL PRERINSE_READY Pre rinse fluid OK 
DETERGENT_READY BOOL DETERGENT_READY Washing fluid OK  
POSTRINSE_READY BOOL POSTRINSE_READY Post rinse fluid OK 
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Block contacts 
The block contacts for the "CIP RETURN" SFC type are summarized in the 
following table: 
Table 4–46 

Name Block I/O name Comment 

V1 VlvL V1 Valve to pre rinse tank 
V2 VlvL V2 Valve to detergent tank 
V3 VlvL V3 Valve to post rinse tank 
M1 MotSpdCL M1 Supply pump 
TIMER1 BlTimer TIMER1 Supply timer 

Sequencers 
The following sequencers are configured in the "CIP SUPPLY" SFC type: 
• PRERINSE: Sets all valves and the pump to automatic mode, opens the 

discharge valve from the pre rinse tank, closes the discharge valves from the 
detergent tank and post rinse tank, starts the pump. 

• DETERGENT: Sets all valves and the pump to automatic mode, opens the 
discharge valve from the detergent tank, closes the discharge valves from the 
pre rinse tank and post rinse tank, starts the pump. 

• POSTRINSE: Sets all valves and the pump to automatic mode, opens the 
discharge valve from the post rinse tank, closes the discharge valves from the 
detergent tank and pre rinse tank, starts the pump.  

• Resuming: Starts the pump after one of the "run sequences" has been paused. 
• Holding: Stops the pump when one of the "washing sequences" is stopped 
• Completing_Abort: Closes all valves, stops the pump and enables it for manual 

operation 
The instance of the "CIP SUPPLY" SFC type is connected to the "RINSETIMER" 
block. This ensures that the specified exposure time for the cleaning fluid in the 
plant section to be cleaned is maintained. The "RINSETIMER" block is an instance 
of the "BlTimer" function block from the BRAUMAT library. 
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PRERINSE 
The "PRERINSE" sequence performs the following actions in the pre rinse phase: 
• Sets the valves in the supply line and the pump to automatic mode 
• Checks that the pre rinse fluid meets the quality requirements and is available 

in sufficient quantity. 
• Closes the valves from the detergent and post rinse tanks 
• Opens the valve from the pre rinse tank 
• Starts the timer 
The "PRERINSE" sequence performs the following actions in the pre rinse phase: 
Table 4–47 

SFC status = Value Logic 

RUN = Run 
AND 

QCS  1 

 
The "PRERINSE" sequencer remains active until the time specified on the timer 
has elapsed. 
The design of the "PRERINSE" sequencer is summarized in the following table: 
Figure 4–19 

Start

Ende

Rü
ck

se
tz

en
 a

lle
r V

en
til

e,
 d

es
 T

im
er

su
nd

 d
er

 t
um

pe
/U

m
sc

ha
ltu

ng
 d

er
 B

et
rie

bs
ar

t /
 V

or
sp

ül
ta

nk
ve

nt
il 

öf
fn

en
, M

ot
or

 st
ar

te
n,

 T
im

er
st

ar
te

n

PR
ER

IN
SE

Ventile und Timer
zurücksetzen

ja

Ventil Vorspültank 
öffnen

ja

Vorspültank 
ok?

ja

Ventile und Motor in 
Automatikbetrieb

Ventile
und Timer

zurückgesetzt?

Ventile
und Motor in

Automatikbetrieb?
ja

Ventil offen?
ja

Motor zurücksetzen

Motor
zurückgesetzt?

ja
Motor starten

Motor
gestartet?Timer starten

ja

ja

 



4 Design and principle of operation 
 

 

CIP – Cleaning in Place 
V2.0, Entry ID: 78463886 60 
 


 S

ie
m

en
s 

AG
 2

01
5 

Al
l r

ig
ht

s 
re

se
rv

ed
 

DETERGENT 
The "DETERGENT" sequencer performs the following actions in the wash phase: 
• Sets the valves in the supply line and the pump to automatic mode. 
• Checks that the detergent fluid meets the quality requirements and is available 

in sufficient quantity. 
• Closes the valves from the pre and post rinse tanks. 
• Opens the valve from the detergent tank. 
• Starts the timer. 
The start conditions for the "DETERGENT" sequencer are summarized in the 
following table: 
Table 4–48 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 2 
 

The "DETERGENT" sequencer remains active until the time specified on the timer 
has elapsed. 
The design of the "DETERGENT" sequencer corresponds to that of the 
"PRERINSE" sequencer, with the following differences: 
• The valve to the post rinse tank is opened instead of the valve to the pre rinse 

tank 
• Different setpoints for the timer 

POSTRINSE 
The "POSTRINSE" sequencer performs the following actions in the post rinse 

phase: 
• Sets the valves in the supply line and the pump to automatic mode. 
• Checks that the post rinse fluid meets the quality requirements and is available 

in sufficient quantity. 
• Closes the valves from the pre rinse and detergent tanks. 
• Opens the valve from the post rinse tank. 
• Starts the timer 
The start conditions for the "PRERINSE" sequencer are summarized in the 
following table: 
Table 4–49 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 3 
 

The "POSTRINSE" sequencer remains active until the time specified on the timer 
has elapsed. 
The design of the "POSTRINSE" sequencer corresponds to that of the 
"PRERINSE" sequencer, with the following differences: 
• The valve to the post rinse tank is opened instead of the valve to the pre rinse 

tank 
• Different setpoints for the timer 
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Completing_Abort 
The "Completing_Abort" sequence closes all valves, enables them for manual 
operation and sets the SFC to the "IDLE" state.  
The start conditions for the "Completing_Abort" sequence are summarized in the 
following table: 
Table 4–50 

SFC status = Value Logic 

ABORTING = Aborting 
OR 

COMPLETING = Completing 

 
The design of the "Completing_Abort" sequence is summarized in the following 
table: 
Figure 4–20
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Holding 
The "Holding" sequencer stops the pump in the supply line when one of the run 
sequencers is paused. The pump is stopped so that mo more fluid is drawn. The 
timer is paused. 
The start conditions for the "Holding" sequencer are summarized in the following 
table: 
Table 4–51 

SFC status = Value Logic 

HOLDING = Holding OR 

 
The design of the "Holding" sequencer is summarized in the following table: 
Figure 4–21 
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Resuming 

The "Resuming" sequencer starts the pump in the supply line when a run 
sequencer is started again. The timer is resumed. 
The start conditions for the "Resuming" sequencer are summarized in the following 
table: 
Table 4–52 

SFC status = Value Logic 

RESUMING = Resuming OR 
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The design of the "Resuming" sequencer is summarized in the following table: 
Figure 4–22 
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4.3.3 FILL_HEAT_CONC 

The "FHC" SFC type instance is started by the operator. It must be permanently 
active so that the cleaning fluid is always available in sufficient quantities of the 
prescribed quality. 
By means of the "FHC" SFC type instance from the "FILL_HEAT_CONC" SFC 
type, the fill level, the temperature and the detergent concentration of the fluid are 
determined and adjusted as required. 
The fluids in the pre and post rinse tanks are not reprocessed in the "CIP" 
application example. These fluids can be reprocessed with the 
"FILL_HEAT_CONC" SFC type. 

Control strategies 
The control strategies for the "FILL_HEAT_CONC" SFC type are summarized in 
the following table: 
Table 4–53 

Control strategy name Comment 

PREPARE Reprocessing of the fluid 
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Setpoints 
The setpoints for the "FILL_HEAT_CONC" SFC type are summarized in the 
following table: 
Table 4–54 

Setpoint name Data 
type 

I/O name Units Comment 

LEVEL REAL LEVEL L Tank level 
HYSTERESIS_LEVEL REAL L_HYS L Fill level hysteresis 
TEMPERATURE REAL TEMP °C Temperature of fluid 
HYSTERESIS_Temp REAL T_HYS °C Temperature 

hysteresis 
CONCENTRATION REAL CONC mS Detergent 

concentration 
HYSTERESIS_Conc REAL C_HYS mS Detergent hysteresis 

Parameters 
The parameters for the "FILL_HEAT_CONC" SFC type are summarized in the 
following table: 
Table 4–55 

Parameter name Data 
type 

I/O name Comment 

LEVEL_SP_HYS REAL LEVEL_SP_HYS - 
TEMP_SP_HYS REAL TEMP_SP_HYS - 
CONC_SP_HYS REAL CONC_SP_HYS - 
LEVEL_CHECK BOOL LEVEL_CHECK - 

Note texts 
The information texts for the "FILL_HEAT_CONC" SFC type are summarized in the 
following table: 
Table 4–56 

Name Number Display text 

CIP_Ready 1 CIP ready? 
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Block contacts 
The block contacte for the "FILL_HEAT_CONC" SFC type are summarized in the 
following table: 
Table 4–57 

Name Block I/O name Comment 

V1 VlvL V1 Fresh water valve 
V2 VlvL V2  
M1 MotL M1 Circulation pump 

motor 
M2 MotL M2 Metering pump 

motor 
LS1 MonDiL LS1 Level monitoring 

high 
LS2 MonDiL LS2 Level monitoring low 
PID1 PIDConL PID1 Temperature 

controllers 
PUPA1 BlPuPa PUPA1 Pulse pause for 

metering 
ANA1 MonAnL ANA1  

Sequencers 
The following sequencers are configured in the "FILL_HEAT_CONC" SFC type: 
• PREPARE: Sets fill level, temperature and detergent concentration 
• ABORTING Closes the valves and stops the pumps 
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PREPARE 
The "PREPARE" sequencer is the run sequencer for the SFC type instance and is 
permanently active.  
The "PREPARE" sequencer performs the following actions: 
• Sets the valves and pumps to automatic mode. 
• Measures the fill level and tops up the fluid. 
• Measures the temperature of the fluid and controls it 
• Measures the concentration of the detergent and controls it 
The sequencer is started by the operator. 
The start conditions for the "PREPARE" sequencer are summarized in the 
following table: 
Table 4–58 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 1 

 
The sequencer remains active until it is stopped by the operator. In the sequencer, 
a check is first made as to whether the fill level is adequate or if it needs to be 
readjusted. If the fill level is adequate, a check is made as to whether the 
temperature is high enough or if it needs to be readjusted  If the fill level and the 
temperature are set, the concentration of the detergent is checked and readjusted 
as necessary. 
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The detergent is metered with the aid of the BlPuPa block (BRAUMAT library) 
which is connected to the SFC type instance. This is used to pulse-drive the 
metering pump over a predefined cycle. 
The design of the "PREPARE" sequencer is described in the following four figures. 
The sequence of the following actions is shown in Figure 4-23. 
• Set the valves and pumps to automatic mode 
• Start the circulation pump 
• Check the fill level 
• Adjust the fill level or jump to the step for checking the temperature or the 

concentration  
Figure 4–23 
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The sequence of the following actions is shown in Figure 4-24. 
• Set the fill level (open /close the fresh water valve) 
• Check the temperature 
• Adjust the temperature or jump to the step for checking the fill level or the 

concentration 
Figure 4–24 
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The sequence of the following actions is shown in Figure 4-25. 
• Set the temperature (circulate the fluid) 
• Check the concentration  
• Adjust the concentration or jump to the step for checking the fill level 
Figure 4–25 
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The sequence of the following actions is shown in Figure 4-26. 
• Set the concentration (start pulse-pause control of the metering pump) 
• Check the concentration  
• Start metering again or jump to the step for checking the fill level 
Figure 4–26 
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ABORTING 
The "ABORTING" sequencer is executed when the "PREPARE" run sequence 
is aborted. 
The "ABORTING" sequencer performs the following actions: 
• Closes all valves 
• Stops all pumps 
The start conditions for the "ABORTING" sequencer are summarized in the 
following table: 
Table 4–59 

SFC status = Value Logic 

ABORTING = Aborting OR 
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The design of the "ABORTING" sequencer is summarized in the following table: 
Figure 4–27 
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4.3.4 TANK_IN 

The SFC type instance is started by SIMATIC BATCH in the cleaning recipes and 
opens or closes the valve to the mixer and activates the BlPuPa block for the valve 
to the drain.  

Control strategies 
The control strategies for the "TANK_IN" SFC type are summarized in the following 
table: 
Table 4–60 

Control strategy name Comment 

PRODUCTION For the production phase 
CIP For cleaning the mixer 

Block contacts 
The block contacts for the "TANK_IN" SFC type are summarized in the following 
table: 
Table 4–61 

Name Block I/O name Comment 

V1 VlvL V1 Mixer valve 
V2 VlvL V2 Drain valve 
PUPA BlPuPa PUPA Connection for 

pulse-pause block 
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Sequencers 
The following sequencers are configured in the "TANK_IN" SFC: 
• PRODUCTION: Opens and closes the valves 
• CIP: Opens and closes the valves; starts the pulse-pause block 
• COMPLETING_ABORT: Closes the valves; resets the pulse-pause block 

PRODUCTION 
The "PRODUCTION" sequencer performs the following actions during production: 
• Resets the valves 
• Sets the valves to automatic mode. 
• Opens the valves 
The start conditions for the "PRODUCTION" sequencer are summarized in the 
following table: 
Table 4–62 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 1 

 
The design of the "PRODUCTION" sequencer is summarized in the following 
figure: 
Figure 4–28 
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CIP 
The "CIP" sequencer performs the following actions during the cleaning phase: 
• Resets the valves and the pulse-pause block 
• Sets the valves and the pulse-pause block to automatic mode. 
• Opens the valve to the mixer and starts the pulse-pause block 
The start conditions for the "CIP" sequencer are summarized in the following table: 
Table 4‑ 63 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 2 

The design of the "CIP" sequencer is summarized in the following figure: 
Figure 4–29 
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COMPLETING_ABORT 
The "COMPLETING_ABORT" sequencer is executed when a run sequence ends 
or has been aborted. The "COMPLETING_ABORT" sequencer performs the 
following actions: 
• Closes all valves and enables them for manual operation. 
• Resets the PuPa and enables it for manual operation. 
• Sets the SFC to the "IDLE" state. 
The start conditions for the "COMPLETING_ABORT" sequence are summarized in 
the following table: 
Table 4–64 

SFC status = Value Logic 

ABORTING = Aborting 
OR 

COMPLETING = Completing 

 
The design of the "CIP" sequencer is summarized in the following figure: 
Figure 4–30 
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4.3.5 TANK_OUT 

The SFC type instance is started by SIMATIC BATCH in the cleaning recipes and 
opens or closes the discharge valve from the mixer and starts or stops the pump 
for pumping out the mixer. 

Control strategies 
The control strategies for the "TANK_OUT" SFC type are summarized in the 
following table: 
Table 4–65 

Control strategy name Comment 

PRODUCTION For the production phase 
CIP For cleaning the mixer 

Block contacts 
The block contacts for the "TANK_OUT" SFC type are summarized in the following 
table: 
Table 4–66 

Name  Block I/O name Comment 

V1 VlvL V1 Mixer valve 
V2 VlvL V2 Valve freely 

available 

M1 MotL M1 Motor for pump 

Sequencers 
The following sequencers are configured in the SFC: 
• PRODUCTION: Opens and closes the valve; starts and stops the motor 
• CIP: Opens and closes the valve; starts and stops the motor 
• COMPLETING_ABORT: Closes the valve and resets it; stops the motor and 

resets it 
• RESUMING: Starts the motor 
• HOLDING: Pauses the motor 

PRODUCTION 
The "PRODUCTION" sequencer performs the following actions during production: 
• Resets the valve and the motor 
• Sets the valve and the motor to automatic mode 
• Opens the valve 
• Starts the motor 
The start conditions for the "PRODUCTION" sequencer are summarized in the 
following table: 
Table 4–67 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 1 
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The design of the "CIP" sequencer is summarized in the following figure: 
Figure 4–31 
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CIP 
The "CIP" sequencer performs the following actions during the cleaning phase: 
• Resets the valve and the motor 
• Sets the valve and the motor to automatic mode 
• Opens the valve 
• Starts the motor 
 
The start conditions for the "CIP" sequencer are summarized in the following table: 
Table 4–68 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 2 
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The design of the "CIP" sequencer is summarized in the following figure: 
Figure 4–32 
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COMPLETING_ABORT 
The "COMPLETING_ABORT" sequencer is executed when a run sequence ends 
or has been aborted. The "COMPLETING_ABORT" sequencer performs the 
following actions: 
• Stops the motor and enables it for manual operation 
• Closes the valve and enables it for manual operation 
• Resets the valve and the motor 
• Sets the SFC to the "IDLE" state. 
The start conditions for the "COMPLETING_ABORT" sequencer are summarized 
in the following table: 
Table 4–69 

SFC status = Value Logic 

ABORTING = Aborting 
OR 

COMPLETING = Completing 
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The design of the "COMPLETING_ABORT" sequencer is summarized in the 
following figure: 
Figure 4–33 
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HOLDING 
The "HOLDING" sequencer is executed when a run sequence has been paused. 
The "HOLDING" sequencer performs the following actions: 
• Stops the motor 
The start conditions for the "HOLDING" sequencer are summarized in the following 
table: 
Table 4–70 

SFC status = Value Logic 

HOLDING = Holding AND 

 
The design of the "HOLDING" sequencer is summarized in the following figure: 
Figure 4–34 
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RESUMING 
The "RESUMING" sequencer is executed when a paused run sequence is started 
again. The "RESUMING" sequencer performs the following actions: 
• Starts the motor 
The start conditions for the "RESUMING" sequencer are summarized in the 
following table: 
Table 4–71 

SFC status = Value Logic 

RESUMING = Resuming AND 

 
The design of the "RESUMING" sequencer is summarized in the following figure: 
Figure 4–35 
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4.4 SIMATIC BATCH 

SIMATIC BATCH is used for discontinuous production. With the aid of SIMATIC 
BATCH, various products can be produced on one system. Manufacture is carried 
out by means of recipes. The recipes contain the knowledge required for 
production. The recipes can be modified by the operating personnel. The complete 
recipe procedure with messages and measurements, as well as the operator 
interventions, is logged. 
In addition to the recipes for manufacturing the product, there are also recipes that 
are used for cleaning the plant sections. 

4.4.1 Cleaning recipes 

Cleaning recipes are used for cleaning the plant sections that are necessary for 
production. 

Information contained in the recipe 
The following information may be contained in the cleaning recipe: 
• Plant section to be cleaned 
• The duration of the cleaning (setpoints for the exposure time for the fluids in 

the plant section) 
• The temperature of the cleaning fluid 
• The detergent concentration in the cleaning fluid 
• The quantity of cleaning fluid (flow rate) 
Various cleaning recipes can be created for a plant section. These differ in the 
above-mentioned details. These differences depend, e.g., on the degree of soiling 
of the plant or on the product that previously was contained in the plant. 
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Structure of a sample recipe 
The "CIP MIXER" sample cleaning recipe in the "CIP" application example is 
intended for cleaning the "Mixer" plant section. It consists of the "TRP MIXER" and 
"TRP CIP" recipe unit procedures (TRP). 
The TRPs and plant sections are summarized in the following table: 
Table 4–72 

TRP Occupied plant section 

TRP MIXER MIXER 
TRP CIP CIP 

For each TRP there exist the three recipe operations (ROP) "PRERINSE", 
"DETERGENT" and "POSTRINSE". The names of the recipe operations 
correspond to the current cleaning phase. The recipe phases (RFs) are called up 
within the ROPs. Each ROP contains two RFs, which run in parallel.  
The RFs are summarized in the following table: 
Table 4–73 

TRP ROP SCRL Control strategy 

MIXER PRERINSE TANK_IN CIP 
TANK_OUT CIP 

DETERGENT TANK_IN CIP 
TANK_OUT CIP 

POSTRINSE TANK_IN CIP 
TANK_OUT CIP 

CIP PRERINSE CIP_SUPPLY PRERINSE 
CIP_RETURN PRERINSE 

DETERGENT CIP_SUPPLY DETERGENT 
CIP_RETURN DETERGENT 

POSTRINSE CIP_SUPPLY POSTRINSE 
CIP_RETURN POSTRINSE 

 
There are synchronization lines between the ROPs so that the process runs 
synchronously in the TRPs. There is a NOP step at the end of the recipe. This is 
necessary so that the last two ROPs will also run synchronously with one another. 
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The following Figure 4-36 describes the design of the cleaning recipe contained in 
the "CIP" application example. 

Figure 4–36 

 
 

4.4.2 Cleaning batches 

The cleaning batches are created as requests in SIMATIC BATCH. The recipe for 
cleaning is defined when the batch is created. 
It is possible to start the cleaning batch automatically immediately at the end of 
a production batch. This ensures that the plant is clean again after the production 
of a product and can be used for further production. 
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5 Launching the application example 
5.1 Preparation 

The following instructions describe putting the application example into service by 
simulating the controller with the "S7-PLCSIM" program. If there is a real controller, 
you must configure existing hardware components in the HW ConFigure 

Preparation in Windows 
The following instructions describe the steps that must be performed in Windows. 

Table 5–1 

No. Action 

1.  Click on “Start”. 
2.  Right-click on "Computer" and open the "Administrate" menu item. The computer 

administration will be opened. 
3.  Right-click on the left side of the window on the "Local users and groups > Groups" menu 

item. Select the "New group" menu command. 
The "New group" window will open. 

4.  Enter "CIPDemoUser" in the "Names" box. 
5.  Add the user name with which you are currently logged in to Windows to this group. 
6.  Click on "Create". 
7.  On the left side of the window, select the "Local users and groups > Users" item. On the 

right side, right-click on the user name with which you are currently logged in Select the 
"Properties" menu item. This opens the "Properties" window. 

8.  Switch to the "Member of" tab and check whether the user is a member of the listed groups. 

 
If the user is not included in all the groups, add him to the missing ones. 
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Preparing the project 
Table 5–2 

No. Action 

1.  Copy the files "78463886_CIP_PCS7V81.zip" and 
"78463886_CIP_PCS7V8SP1_BATCH_BACKUP.sbb" into any folder on the configuration PC 
and then open the SIMATIC Manager. 

2.  In the menu bar, click on "File > Dearchive" and select the file "78463886_CIP_PCS7V81.zip". 
Then confirm with "Open". 

3.  Select the folder in which the project will be saved and confirm with the "OK" button. 
The project will be extracted. 

4.  In the "Retrieve" dialog, click on the "OK" button and then click on "Yes" in the dialog to open 
the project. 

5.  Right-click on "CIP_OS > ESV81" and click on the "Object properties" menu item. 
6.  Enter the name of your PC in the "Name" box and click on "OK". 

 
7.  Right-click on "CIP_OS > Name of your PC > WinCC Appl > OS" and click on the "Open 

object" menu command. 

8.  Confirm the "Configured server not available" dialog with "OK". 
9.  In the WinCC Explorer, open the characteristics of your computer and, in the opened 

Characteristics dialog, click on the "Use local computer name" button. Confirm the "Change 
computer name" messages with "OK". 

 
10.  In WinCC Explorer, click on "File > End" and, in the subsequent dialog, select "Terminate 

WinCC Explorer and close project" with "OK". 

11.  Reopen the WinCC Explorer as described in step 7. 
12.  Open by double-clicking the "OS project editor". 
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No. Action 

13.  In the "Layout" tab under "Available layouts", select the "SIMATIC Standard" screen 
corresponding to the screen resolution that is set. 

 
Click on "OK" to accept the settings and close the "OS project editor". 

14.  Exit WinCC Explorer as described in step 10. 
15.  In the windows task bar, right-click on the icon for the SIMATIC BATCH Launch Coordinator 

and select the "Change start mode from > Automatic to manual" menu command. 

 
 
Note 
The SIMATIC BATCH Launch Coordinator starts automatically when the PC is started. 
If SIMATIC BATCH does not start, proceed as follows: 
Click on "Start > All programs > Siemens Automation > SIMATIC > BATCH Launch 
Coordinator". 
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5.2 Working on the multiproject 
The following instructions describe the work that must be performed on the 
multiproject. It is required that SIMATIC Manager is already open and that 
the project has been selected in the component view. 

Table 5–3 

No. Action 

1.  Right-click on CIP_AS > AS1 > CPU 410-5H > S7-program(1) > Charts and click the menu 
command "Compile". 

2.  In the "Compile program" dialog, select the "Entire program" item and deactivate the 
"Generate module drivers" option then confirm it with "OK". 

 
3.  Close the compiler log. 
4.  Right-click on CIP_OS > ESV81 (Name of PC station) > WinCC Appl. > OS and click on 

the menu command "Compile". The compiler dialog opens. 

5.  Press "Next". 
6.  Press "Next". 
7.  Make sure that all areas are selected and press "Next". 

 
8.  Select the following settings and press "Next". 

 
9.  Then press "Compile". 
10.  Confirm the "Compile OS" dialog with "OK". 
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No. Action 

11.  In SIMATIC Manager, right click on the "DEMO_CIP > SIMATIC BATCH" multiproject and 
select the "Open configuration dialog" menu command. The SIMATIC BATCH configuration 
dialog is opened. 

12.  In the BATCH dialog, select the "DEMO_CIP" multiproject and then click on "Settings". 

 
The "Settings" window opens. 

13.  In the "Distribution" tab, click on "Update". 
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No. Action 

14.  In the "OS objects" tab, click on "Update". 

 
15.  In the "Process cells" tab, click on "Update". 

 
 

16.  Click on "OK" to quit the "Settings" window. 
17.  Select the "BATCH types" item and click on "Generate" and then on "Start".

 
Then click on "Close". 
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No. Action 

18.  Select the "BATCH types" item and click on "Propagate" and then on "Start". 
Then click on "Close". 

19.  Select the "BATCH instances" item and click on "Merge" and then on "Start". 

 
Then click on "Close". 

20.  Select the "PRODUCTION" item and click on "Transfer messages". Confirm the "Transfer 
messages to OS" dialog with "Yes". 
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No. Action 

21.  Select the "PRODUCTION" item and click on "Download". 

 
Click on “Start”. 
Then click on "Close". 

22.  End the SIMATIC BATCH configuration dialog with "OK". 
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5.3 Start-up 

The following instructions describe how the "CIP" application example is initialized: 
To put into service, it is required that SIMATIC Manager is already open and that 
the project has been selected in the component view. 

Starting the simulation (S7-PLCSIM) 
To start the simulation, proceed according to the following instructions: 

Table 5–4 

No. Action 

1.  Select "Extras > Simulate module" from the menu. 
The "S7-PLCSIM" dialog window opens. 

2.  In the menu, select "Execute > Key-switch position > Run-P". 
3.  Switch to the component view of SIMATIC Manager and select "CiP_AS > AS1 > 

CPU 410-5H > S7-program > Charts“. 
4.  In the menu bar, click on "Target system > Load" and confirm the "Load" dialog with "Yes". 

Confirm the "Stop target group" dialog with "OK" and the subsequent "Load" dialog with "Yes". 

Activate OS (WinCC Runtime) 
To activate the OS, proceed according to the following instructions: 

Table 5–5 

No. Action 

1.  Right-click on "CIP_OS > ESV81 >WinCC Appl. > OS" and click on the menu command  
"open object". 

2.  To activate the OS (WinCC Runtime), select "File > Activate" in the WinCC Explorer menu. 
3.  Log into the SIMATIC Logon Dialog using your Windows user ID. 

 
4.  Select "CIP" in the icon area. 
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Activating SIMATIC BATCH 
To activate SIMATIC BATCH, proceed according to the following instructions: 

Table 5–6 

No. Action 

1.  Click on the Windows logo key on your keyboard to bring up the Windows task bar. 
2.  

There is a green "Stop" symbol in the icon for the SIMATIC BATCH Launch Coordinator . 
The currently loaded "DEMO_CIP" project is displayed as a tool-tip text. 

3.  Right-click on the icon for the SIMATIC BATCH Launch Coordinator and select the "BATCH 
Runtime > Start" menu command to start SIMATIC BATCH Runtime. 

 

There will be an "hourglass"  in the icon for the SIMATIC BATCH Launch Coordinator. 
This indicates that the SIMATIC BATCH server is about to be started. The "hourglass" turns 

into a "Play" symbol . The SIMATIC BATCH server is now in the "Run" state. 
4.  Click on "Start > All programs > Siemens Automation > SIMATIC > BATCH Control Center". 

The BATCH Control Center opens. 

5.  Click on the "Extras" menu item and select the "Restore" menu command. 
The Restore dialog opens. 

 
6.  Navigate to the storage location of the "78463886_CIP_PCS7V81_BATCH_BACKUP" file and 

select it. Click on "Open". 
7.  Click on the "PRODUCTION" process cell symbol and click on the menu command "Update 

the process cell". 
8.  Confirm the "Update the process cell" dialog with "OK". 
9.  Click on the "Extras" menu item and select the "Role management" menu command. 

The "SIMATIC Logon Role Manager" will open. 
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No. Action 

10.  In the "Configured roles and assignment types" window, right-click on "Roles > Superusers > 
Groups and users". Select the "Edit" menu command. 

 
The "Edit groups and users" window will open. 

11.  Click on the "List" button. 
All the available groups and users will be listed for you. 

12.  Add the group "CIPDemoUsers" to "Configured groups and users". 
13.  Click on the "OK" button to exit the "Edit groups and users" window. 
14.  In the "SIMATIC Logon Role Management" window, click on "File > Save". 
15.  In the "SIMATIC Logon Role Management" window, click on "File > Exit". 
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6 Operation of the application 
6.1 Overview 

The following sections describe the operation of the application example. 
Three different scenarios will be described. 
• Manual operation of the individual functions in the WinCC overview picture 
• Creating and starting a cleaning batch from the SIMATIC BATCH Control 

Center 
• Creating and starting a cleaning batch with the SIMATIC BATCH controls 

directly from WinCC Runtime 

6.2 Scenario A 

Description 
In this scenario, dealing with the plant in manual mode is explained. Here you will 
be able to operate the individual components of the CIP system and,e.g., perform 
an adjustment of the detergent concentration in the detergent tank. 
The following instructions describe starting the reprocessing of the washing fluid 
in the detergent tank,  The following points are a prerequisite: 
• WinCC Runtime is active 
• The S7 program is loaded in "S7-PLCSIM" and the key switch is set to Run(-P) 
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Table 6–1 

No. Action 

1.  Open the plant overview picture.for the CIP system. 
2.  Set the following values at the marked process tags: 

1 2

3

4

5

 
1. Concentration in return line to 50 mS 
2. Temperature in return line to 35 °C 
3. Concentration in heating circuit to 150 mS 
4. Temperature in tank to 85 °C 
5. Tank capacity to 20000 L 

3.  Click on the "Faceplate" button in the "DETERGENT/FHC" SFC control 

 
The faceplate for the "DETERGENT/FHC" SFC opens. 
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No. Action 

4.  Click on "MANUAL" to switch the SFC from automatic mode to manual mode, 

  
Confirm the "SFC operation" dialog with "OK". 

5.  Select the "PREPARE" control strategy. 

 
Confirm the "SFC operation" dialog with "OK". 
The setpoints and current actual values will be displayed. 

6.  Start the SFC by clicking on the "Start" button on the "DETERGENT/FHC" SFC faceplate. 
Confirm the "SFC operation" dialog with "OK". 
The SFC starts and remains at the "LEVEL CHECK" step. 

7.  Change the  process value for the current temperature in the tank to 75°C (see Point 4 in 
Step 2). 
The SFC changes to the "TEMP CHECK" step. 

8.  Change the temperature again to 85°C. 
The SFC jumps to the "LEVEL CHECK" step. 

9.  Change the value for the fill level to less than 17500 L (see Point 5 in Step 2). 
The SFC jumps to the "LEVEL REACHED?" step and the fresh water valve is opened. 

10.  Change the value for the fill level again to 20000 L. 
The SFC jumps back to the "LEVEL CHECK" step. 

11.  Change the value for the concentration in the heating circuit to 115 mS (see Point 3 in 
Step 2). 
The SFC jumps to the "CHECK PUPA" step. The BlPuPa module is started. This pulse-drives 
the metering pump. 
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No. Action 

12.  Click on the PUPA block icon to open the associated faceplate. You can see the pulse and 
pause times in the faceplate. 

 
If the value for the concentration is still not adequate after a predefined number of loops, 
a message is transmitted. 

13.  Set the values for temperature, concentration and fill level so that the "LEVEL CHECK" step 
is active. 

14.  Click on the block icon for the "UNIT_CIP" UNIT_PLC block in order to open the UNIT_PLC 
faceplate. 

 
15.  Switch to the "Functions" view. 
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No. Action 

16.  Click "CIP RETURN". Then click on the "CIP RETURN" button. To open the faceplate for the 
"CIP RETURN" SFC, confirm the entry by clicking on the "OK" button. 
 

 
17.  Click on the "MANUAL" button to switch the SFC from automatic mode to manual mode. 

Confirm the "SFC operation" dialog with "OK". 
18.  Select the "PRERINSE" control strategy and start the SFC. 

Confirm the "SFC operation" dialog with "OK". 
19.  Click on the "Start" button to start the SFC. 

Confirm the "SFC operation" dialog with "OK". 
The valve to the drain opens. 
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No. Action 

20.  The SFC is not self-terminating and is in the "Ready to complete" state.  
 

 
21.  Click on the "Exit" button on the SFC faceplate to exit the SFC. 

Confirm the "SFC operation" dialog with "OK". 
22.  Click on the "Reset" button to set the SFC to the "IDLE" state. 

Confirm the "SFC operation" dialog with "OK". 
23.  Switch to the "DETERGENT" control strategy. 

Confirm the "SFC operation" dialog with "OK". 
Start the SFC. 
Confirm the "SFC operation" dialog with "OK". 

24.  Alter the process values for concentration and temperature in the return line of the CIP 
system. 

25.  To do this, click on the block icons for the "QIT_Return" and "TIT_Return" analog monitoring 
blocks (see Points 1 and 2 in Step 2). 

 
26.  Change the values and observe the valves in the return line. 

Depending on the values, the valves to the tanks or to the drain will be opened. 
27.  Activate the level monitoring for the pre rinse or detergent tank. 

 
No more fluid will be fed into the tank for which the level monitoring is active. 

28.  Click on the "Exit" button to exit the "CIP_RETURN" SFC. 
Confirm the "SFC operation" dialog with "OK". 
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No. Action 

29.  Click on the "Reset" button to set the SFC to the "IDLE" state. 
Confirm the "SFC operation" dialog with "OK". 
Note 
The "POSTRINSE" control strategy behaves identically to the "DETERGENT" control 
strategy. 

30.  Click on the "AUTO" button to switch the "CIP_RETURN" SFC from manual mode to 
automatic mode. 
Confirm the "SFC operation" dialog with "OK". 

31.  Click on the block icon for the "UNIT_CIP" UNIT_PLC block in order to open the UNIT_PLC 
faceplate. 

32.  Switch to the "Functions" view. 
33.  Click on the "CIP SUPPLY" button to open the faceplate for the "SUPPLY" SFC. 
34.  Click on the "MANUAL" button to switch the SFC from automatic mode to manual mode. 

Confirm the "SFC operation" dialog with "OK". 
35.  Select the "PRERINSE" control strategy. 

Confirm the "SFC operation" dialog with "OK". 
36.  Click on the "Start" button to start the SFC. 

Confirm the "SFC operation" dialog with "OK". 
The valve from the pre rinse tank opens and the supply pump is started. 
The sequencer remains active until the time set on the timer has elapsed. If the sequencer 
is paused with the "Pause" button, the timer will also be paused. On resuming with the 
"Resume" button, the timer will run again. 
Note: 
The "DETERGENT" and "POSTRINSE" control strategies behave identically. 

37.  All three control strategies are started if the "LEVEL CHECK" step is active in the 
"DETERGENT" SFC. 

38.  When the sequencers have run to the end, the SFC is in the "Ended" state. 
Click on the "Reset" button to set the SFC to the "IDLE" state. 
Confirm the "SFC operation" dialog with "OK". 

39.  Click on the "AUTO" button to switch the SFC from manual mode to automatic mode. 
Confirm the "SFC operation" dialog with "OK". 
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6.3 Scenario B 

In Scenario A you were acquainted with the individual functions of the CIP system 
in manual operation. The following will describe how to use these functions with 
SIMATIC BATCH. Here, operation is carried out from the SIMATIC BATCH Control 
Center. 
The following points are a prerequisite: 
• WinCC Runtime is active 
• The S7 program is loaded in "S7-PLCSIM" and the key switch is set to Run(-P) 
• The SIMATIC BATCH server is in the "Run" state 
• The "DETERGENT" SFC is in the "Run" state (active "LEVEL CHECK" step) 
• The supplied backup has been imported 
• Role management has already been carried out 

Table 6–2 

No. Action 

1.  In the key area, click on the "Key set change" button. 

 
2.  In the key area, click on the "BATCH Control Center" button. 

 
The SIMATIC BATCH Control Center opens. 

3.  Right-click on "Orders" and select the "New" menu command. 

 
This opens the "Generate order category" window. 

4.  Enter a suitable name (e.g. CIP) in the "Names" box and click on the "OK" button. 
5.  Right-click on "CIP" and select the "New" menu command. 

The "Create order" window opens. 
6.  In the "General" tab, enter a suitable name (e.g. CIP MIXER) in the "Names" box. 
7.  Switch to the “Batches” tab. 
8.  Click on the "New" button. 

The "Selection of formula or master recipe" window opens. 
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No. Action 

9.  Select the "CIP MIXER V1.2" master recipe and then click on the "OK" button. 

 
10.  Give the batch in the "Create order" window a suitable name. 

Click on the "OK" button in the "Create order" window. 
You have now created a new order with a batch. 

 
11.  Right-click on the batch and select the "Release" menu command. 

Confirm the dialog window that opens with "Yes". 
12.  Double click on the batch. 

The control recipe will be displayed for you. 
13.  Right-click on the batch and select the "Start" menu command. 

Confirm the dialog window that opens with "Yes". 
The batch will be started. SIMATIC BATCH now occupies the plant sections and starts 
the SFCs. All the control strategies are run through one after another. 

14.  Switch to WinCC Runtime and observe the individual valves and pumps being actuated. 
15.  Change the values for the temperature and concentration in the return line (see Points 1 and 

2 in Step 2 in Scenario A) The valves to the tanks and to the drain will be opened or closed 
according to the change. 

16.  Switch to the "Mixer" process picture. 
Here also the valves and the pump on the mixer are actuated. 

17.  The batch ends automatically. 
The SFCs that were started are terminated and reset to the "IDLE" state by SIMATIC BATCH. 
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6.4 Scenario C 
In Scenario A you were acquainted with the individual functions of the CIP system 
in manual operation. The following will describe how to use these functions with 
SIMATIC BATCH. Operation takes place here in WinCC Runtime via the SIMATIC 
BATCH OS controls (BATCH OCXs). The following points are a prerequisite: 
• WinCC Runtime is active 
• The S7 program is loaded in "S7-PLCSIM" and the key switch is set to Run(-P) 
• The SIMATIC BATCH server is in the "Run" state 
• The "DETERGENT" SFC is in the "Run" state (active "LEVEL CHECK" step) 
• The supplied backup has been imported 
• Role management has already been carried out 
• The order has been created in SIMATIC BATCH Control Center 

Table 6–3 

No. Action 

1.  Open the "RECIPE CONTROL" screen in WinCC Runtime. 
2.  Right-click on the "DEMO_CIP" project in the "Projects" BATCH OCX and select the "Connect 

project" menu command. 

 
3.  Click on the button next to "Formula" in the "Batch generation" BATCH OCX. 
4.  Select the "CIP MIXER V1.2" recipe in the "Select recipe/formula" window. Click on "OK". 

 
5.  Click on the button next to "Order category" in the "Batch generation" BATCH OCX. 
6.  Select the order "CIP MIXER" (needs to have been created previously in BATCH Control 

Center) in the "Select order" window. 
Click on "OK". 

 
7.  Enter a suitable name in the "Name" box in the "Batch generation" BATCH OCX. 
8.  Adjust the start time in the "Batch generation" BATCH OCX. 
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No. Action 

9.  Click on the "Release batch(es)" button in the "Batch generation" BATCH OCX. 
10.  Click on "Yes" in the "Confirmation" dialog. 

The batch will be created and released. 
11.  In the "Batch list" BATCH OCX, right-click on the batch that you created previously and select 

the "Start batch" menu command. 

 
12.  Click on "Yes" in the "Confirmation" dialog box. 
13.  You can see the plant sections occupied by the batch in the "TA list" BATCH OCX. 

 
14.  Double click on the occupied plant sections. 

The control recipe will be displayed for you in the "ROP overview" BATCH OCX. 
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7 Literature 
7.1 Related documents 

This list is by no means complete and merely reflects a selection of suitable 
literature. 
Table 7–1  

 Subject area Title 

/1/ Practical manual for controllers 
with SIMATIC S7 and SIMATIC 
PCS7 for process automation 

Controlling with SIMATIC 
Müller, Jürgen / Pfeiffer, Bernd-Markus / 
Wieser, Roland  
Publicis Kommunikationsagentur  
ISBN 978-3895783401 

/2/ Process engineering TECHNOLOGIE Brauer & Mälzer 
Kunze, Wolfgang / Manger, Hans-Jürgen 
Publicis Kommunikationsagentur  
ISBN 978-3-921690-56-7 

7.2 Internet links 
This list is by no means complete and merely reflects a selection of suitable 
information. 
Table 7–2  

 Subject area Title 

\1\ Siemens Industry Online Support http://support.automation.siemens.com 

\2\ Integration of S7-300 Package Units 
and Operator Panels in SIMATIC PCS 7 
with PCS 7 Industry Library 

http://support.automation.siemens.com/WW/
view/en/78463886 
 

\1\ SIMATIC PCS 7 in Industry Online 
Support - Overview page 

www.siemens.de/industry/onlinesupport/pcs7 

\2\ SIMATIC Process Control System PCS 
7 Compendium Part C - Technical 
Functions with SFC Types 

https://support.industry.siemens.com/cs/ww/
en/view/109098121 

\3\ SIMATIC PCS 7 overview (collection of 
links for FAQ, manuals, compendium, 
forum, application examples and 
multimedia)  

http://support.automation.siemens.com/WW/
view/en/63481413 
 

\4\ SIMATIC Process Control System PCS 
7 SIMATIC BATCH V8. 1" 

http://support.automation.siemens.com/WW/
view/en/106471750  

\5\ PCS 7 V8. 1 Manual Collection http://support.automation.siemens.com/WW/
view/en/59538371 

\6\ SIMATIC Process Control System 
PCS 7 PCS 7 BRAUMAT Library V7.1 

http://support.automation.siemens.com/WW/
view/en/60307664  

 
 

http://support.automation.siemens.com/
http://support.automation.siemens.com/WW/view/en/78463886
http://support.automation.siemens.com/WW/view/en/78463886
http://www.siemens.de/industry/onlinesupport/pcs7
http://support.automation.siemens.com/WW/view/en/63481413
http://support.automation.siemens.com/WW/view/en/63481413
http://support.automation.siemens.com/WW/view/en/68154748
http://support.automation.siemens.com/WW/view/en/68154748
http://support.automation.siemens.com/WW/view/en/59538371
http://support.automation.siemens.com/WW/view/en/59538371
http://support.automation.siemens.com/WW/view/en/60307664
http://support.automation.siemens.com/WW/view/en/60307664
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8 History 
Table 8–1  

Version Date Change  

V1.0 10/2013 First edition 
V2.0 02/2015 Updating to PCS 7 V8.1 

 


	PCS 7 Unit Template“CIP – Cleaning in Place”
	Warranty and liability
	Table of contents
	1 Automation Task
	2 Automation Solution
	2.1 Overview of the complete solution
	2.2 Core functionality
	2.2.1 Description of the individual functions
	2.2.2 PI process picture

	2.3 Hardware and software components used

	3 Basics
	3.1 Process engineering
	3.2 Automation technology

	4 Design and principle of operation
	4.1 Project structure
	4.1.1 CFC chart structures
	4.1.2 Technological perspective

	4.2 Technical functions and measurement points
	4.2.1 CIP SUPPLY
	4.2.2 CIP RETURN
	4.2.3 Detergent tank
	4.2.4 Fresh water tank (post rinse tank)
	4.2.5 Pre rinse tank
	4.2.6 Mixer
	4.2.7 Mixer supply (TANK_IN)
	4.2.8 Mixer discharge (TANK_OUT)

	4.3 Sequencers (SFC type instances)
	4.3.1 CIP RETURN
	4.3.2 CIP SUPPLY
	4.3.3 FILL_HEAT_CONC
	4.3.4 TANK_IN
	4.3.5 TANK_OUT

	4.4 SIMATIC BATCH
	4.4.1 Cleaning recipes
	4.4.2 Cleaning batches


	5 Launching the application example
	5.1 Preparation
	5.2 Working on the multiproject
	5.3 Start-up

	6 Operation of the application
	6.1 Overview
	6.2 Scenario A
	6.3 Scenario B
	6.4 Scenario C

	7 Literature
	7.1 Related documents
	7.2 Internet links

	8 History



